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Visual COBOL 10.0 for ISVs Release Notes
These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Note:

• This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.

• Check the Product Documentation section of the OpenText Support and Services Documentation
Web site for Micro Focus products for any documentation updates.

Product Overview

The Micro Focus Visual COBOL for ISVs package comprises the following products which you can
download from your Electronic Product Delivery Note:

• Visual COBOL for Visual Studio - delivers the richest development experience for COBOL programming
available on Windows using Microsoft's Visual Studio 2022. Visual COBOL supports the development
and deployment of both managed .NET and native COBOL applications.

• Visual COBOL for Eclipse - provides an Eclipse-based integrated COBOL development environment for
Windows or Linux. Provides COBOL JVM support and enhanced compatibility with ACUCOBOL. Can
be used standalone for developing local applications or in conjunction with the Development Hub to
develop remote projects in Linux and UNIX.

• Visual COBOL Development Hub - provides a rich desktop development environment based on the
Eclipse IDE with high-performance server-based tools for managing builds, source code access and
debugger engine. The Development Hub also provides a central administration site, simplifying the
development tool distribution and maintenance process.

Upgrading from earlier Micro Focus products

This version of your product is dependent on a later version of the Microsoft C run-time system than earlier
Micro Focus products. This means that COBOL executables (.exe) built with a version earlier than 4.0
might not be compatible with the current version of the run-time products. If the behavior of your application
changes with the current version, we strongly recommend that you relink the main executable with the
current version. This will ensure that the COBOL run-time system fully handles any run-time error
conditions that might occur.

A new executable that is fully compatible with the current version can be produced without recompiling the
application, as long as the original object code is available and it is relinked with the current version.

To allow your executables to benefit from the product's latest programming and performance
enhancements, we recommend a full recompilation of your source code.

If you are using Visual Studio, you can configure the IDE to automatically check whether applications
created with older releases must be relinked. If the application uses an older version of the C run-time
system, Visual COBOL can automatically relink the existing executable or .dll to the new version of the C
run-time system without the need to recompile the application first. If a project needs relinking, Visual
Studio displays a message in the status bar providing an option for you to choose and relink the project.

If you are using Eclipse, Visual COBOL can automatically relink existing projects created with Visual
COBOL earlier than 4.0 that have executable link artefacts. Eclipse displays a warning in the Problems
view that the project requires relinking. It then offers a Quick Fix action for you to execute that will link your
project with the most recent version of the Run-Time System.
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What's New
Enhancements are available in the following areas:

• Rocket COBOL Extensions for Visual Studio Code
• .NET Support
• COBOL Language
• Code Analysis and a Natural Language Assistant
• Compiler Directives
• Containers
• Customer Experience Improvement Program
• Database Connectors
• Eclipse Integration
• Enterprise Server
• Enterprise Server Common Web Administration (ESCWA)
• Enterprise Server Security
• Interface Mapping Toolkit
• Licensing Changes
• Micro Focus Unit Testing Framework
• OpenTelemetry
• Visual Studio Integration

Rocket COBOL and Enterprise Extensions for Visual
Studio Code

Back to Top

The Micro Focus COBOL and Enterprise extensions for Visual Studio Code have been repackaged by
Rocket Software on the Microsoft Visual Studio Marketplace.

• The Rocket COBOL extension for Visual Studio Code (formerly Micro Focus COBOL Extension for
Visual Studio Code) provides COBOL edit, compile and debug support for Visual COBOL and
Enterprise Developer users in Visual Studio Code.

• The Rocket Enterprise extension for Visual Studio Code (formerly Micro Focus Enterprise extension for
Visual Studio Code) provides PL/I edit, compile and debug support for Enterprise Developer users in
Visual Studio Code. This extension installs the Rocket COBOL extension.

• The Rocket JVM COBOL extension for Visual Studio Code (formerly Micro Focus JVM COBOL
extension for Visual Studio Code) provides support for debugging JVM COBOL code in Visual Studio
Code.

• The Learn COBOL extension for Visual Studio Code provides all training materials for the Micro Focus
COBOL Fundamentals Training course.

New enhancements in this release are:

• Support for accepting command-line arguments in COBOL notebooks.
• New debug launch options - console and integrated Terminal support for platform specific values in the

launch.json file.

• Support is available for fine-tuning the colors of different parts of the code in the editor via Visual Studio
Code's settings.json file. This requires a minimum release 10.0 of Visual COBOL.
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Note: These extensions are not included with the Visual COBOL installer. They are available from the
Microsoft Visual Studio Marketplace website. All of the extensions are available on Windows and
Linux.

.NET Support
Back to Top

This release provides the following enhancements to .NET support:

• .NET COBOL projects now target .NET 8. You can use Visual Studio, .NET 8 SDK or Visual Studio
Code to build .NET 8 COBOL projects. Earlier versions of .NET are not supported. Support for
building .NET Framework 4.x COBOL projects using Visual Studio remains unchanged.

COBOL Language
Back to Top

This release includes the following enhancements:

• The FREE statement - under the MF dialect, you can now free memory, allocated via the ALLOCATE
statement, directly by using FREE ADDRESS OF data-name. This negates the need to specify a
returning pointer during allocation (i.e. ALLOCATE data-name RETURNING my-pointer) and then
freeing the pointer.

• COBOL/Java interoperability - the following features have been added to the COBOL and Java
interoperability for native COBOL code:

• Support for the use of dynamic length COBOL items when running under an MF dialect. See
Mapping COBOL Items and Java Types.

• User-defined exception handling when calling Java static methods. See Example 5 - Exception
Reporting When Calling Java Static Methods.

• The entry_point_mapper_disable_auto_aliasing run-time tunable - this new tunable has been
introduced to determine whether the Entry Point Mapping facility should not emulate the alias function of
an IBM mainframe linkage editor, and instead generate a COBRT173 Called program file not
found in drive/directory run-time system error.

• Enterprise COBOL support - the following enhancements provide greater compatibility with IBM
Enterprise COBOL version 6.4:

• The STRING and UNSTRING statements now support USAGE UTF-8 data items.
• The ENCODING phrase of the JSON-GENERATE and JSON-PARSE statements is now supported.
• The ENTRY-NAME and ENTRY-INTERFACE clauses of the Function-ID paragraph are now

supported; however, these clauses are strictly documentary.
• New MF Level - this release includes a new default level (MF"23") of reserved words. See Reserved

Words Table for words associated with this level.
• Pointer dereferencing - improvements have been made in the ability to dereference pointers using

both the DATA...AT and :: (colon-colon) syntax. See Pointer Dereferencing.

Code Analysis and a Natural Language Analysis Assistant
Back to Top

This release includes the following enhancements related to integration with COBOL Analyzer and
Enterprise Analyzer:
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• Natural Language Analysis Assistant in the IDE - integration with COBOL Analyzer and Enterprise
Analyzer now provides a natural language Analysis Assistant chat window in the IDE. You can type
queries about a COBOL workspace in a COBOL Analyzer or an Enterprise Analyzer repository. From
the Analysis Assistant window results you can open Program Flow Graphs, view Complexity Reports,
and open COBOL source files.

Note: This functionality requires a licensed copy of either COBOL Analyzer 10.0 or Enterprise
Analyzer 10.0.

• Complexity reports (Eclipse only) - you can now generate a Complexity Report for a workspace in the
Application Server Explorer view. A complexity report enables you to view and compare various
metrics of files in your workspace.

• On Windows inside Eclipse, the Program Flow Graph (Windows only) is now available from Server
Explorer for workspaces and source files in COBOL Analyzer and Enterprise Analyzer in the Eclipse
IDE.

Compiler Directives
Back to Top

The following Compiler directive is new in this release:

• ILPOINTER-REFERENCE - Determines how a pointer used as a method parameter is passed if BY
VALUE or BY REFERENCE is not specified as part of the parameter.

Containers
Back to Top

On Ubuntu platforms, this product now provides a full development containers demonstration capable of
providing a full COBOL development environment, running in a container, accessible from Visual Studio
Code; see Running the Development Containers Demonstration Base Image for more information.

Customer Experience Improvement Program
Back to Top

Starting this release, the Customer Experience Improvement Program collects high-level, anonymous
information on how Micro Focus products are used. The information collected includes product name and
version, OS in use, and features used with the purpose to improve the products and, consequently, the
customer experience.

Customer Experience Improvement Program participation is enabled by default. You can opt out with the
help of the mfceipconfig command-line utility.

Database Connectors
Back to Top

• The CARRIAGE-CONTROL-FILTER XFD directive - enables carriage control characters to be retained
when AcuXDBC reads a LINE SEQUENTIAL data file.
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Eclipse Integration
Back to Top

This release provides the following enhancements:

• Visual COBOL supports, and is shipped with, Eclipse 4.28 (2023-06). Versions of Eclipse prior to this
one are not supported.

• Quick fixes - quick fix functionality has been enhanced to provide a list of possible fixes that can
automatically be applied from the popup box displayed when hovering over an error in the editor; this is
similar to the functionality provided when working with Java.

• Pre- and post-build processing events - script files used as part of build processing events
(Properties > Micro Focus > Build Configurations > Events) can now be coded to affect the
outcome of the COBOL build process, and also introduce error messages into the IDE. See Pre- and
post-build processing events.

• Copybook Graph support - you can now see a graph of the copybook dependencies of COBOL files.
The graph enables you to see any incoming and outgoing dependencies.

• Copybook Paths preference - a new preference page has been introduced to help locate copybook
files, referenced in standalone files, when debugging. Use this page if your copybook files (or the files
that call them) have been moved from their original (built) location. The list is searched in order until a
match is found.

• Conditional breakpoints when debugging JVM COBOL now support the use of the following
operators: <, >, <=, and >= within expressions.

• Formatting preferences applied on sentence termination - a new formatting preference (Window >
Preferences > Micro Focus > COBOL > Editor > Typing > Format sentence on period) formats the
current sentence as per the current formatter profile settings, when it is terminated by a period.

Enterprise Server
Back to Top

This release provides the following enhancements:

• Remote File Access - it is now possible to remotely access files using a configured Remote File Access
(RFA) MFCS Connector. You can access ordinary files, cataloged datasets, and spool output. This also
enables remote editing of COBOL data files using the new Data Tools utility. This enables you to
download and upload files, datasets, and spool output locally or remotely using the existing Enterprise
Server Security configuration. Various security features make this solution a more secure alternative to
more generic solutions such as FTP and SSH.

Enterprise Server Common Web Administration (ESCWA)
Back to Top

This release includes the following enhancements:

• Catalog view has improved filtering options and now includes paging. A new Load on navigation check
box enables you to filter based on the previously selected conditions. See Catalog List in the product
Help.

• A new Configuration Report page enables you to visualize potential security vulnerabilities in the
ESCWA and MFDS configurations. Each domain and configuration attribute combination has its own
help dialog. See Configuration Report in the product Help.

• Role-based security configuration. You can now configure a users view of ESCWA. If a user does not
require specific roles then you can hide corresponding pages and API. You can configure the role-based
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access from the Role Options page. Click Security , expand ESCWA Configuration followed by the
ESM, and then click Roles. See Role Options in the product Help.

Note: Role-based security is an ESCWA only feature that works on top of existing product security.

• It is now possible to remove Locks, if necessary, to fix applications that are broken due to a lock that has
not been removed. You can enable this feature from the Locks page. Click Native > Monitor > Locks,
and then click Remove Locks. This functionality is controlled by the casstop resource entity in the
OPERCMDS resource class. See Locks in the product Help.

Caution: Incorrectly removing locks can result in system instability and corruption or loss of data.

• Region verification - ESCWA can now verify the configuration of selected components for an enterprise
server region. You can use this feature to identify potential start up or configuration issues for the
selected region. The verification process uses the casverify utility to perform the verification action. See
Verify in the product Help.

• Improved CICS resource navigation. Active resources can now be filtered by group and large sets of
filtered data can be paged.

• The API return codes have been improved. Previously, when the region monitor and control APIs were
called, they would return a HTTP 200 code, with the error specified in the JSON output. The return
codes have been improved to give more information. You can configure the API to use the new or old
behavior.

• The ESCWA user interface is now more responsive and can be used with a greater variety of smaller
Web browsers.

Enterprise Server Security
Back to Top

This release includes the following enhancements:

• Enterprise Server security features provided by the VSAM External Security Manager (ESM) module
are enabled by default. You will need to supply valid credentials when you interact with ESCWA, the
Micro Focus Directory Server and regions in the browser based UI or in the IDE, use certain utilities
from the command line, use TN3270 emulator to access regions, log into or with FileShare. See After
Installing > Enterprise Server Security Features for details on how to configure this product.

• TLS Certificate Checking Utility - a new executable in the product that can be used to help diagnose
problems with TLS certificates. It can check the validity of certificates, verify certificate chains, check
that certificates and private keys match and check that a certificate contains a SAN that matches a
provided hostname/address. Improves TLS usability by diagnosing TLS certificate problems. See
CertChecker Utility for more information.

• The VSAM ESM Module, which provides file-based security for Enterprise Server is now a GA quality.

• User authentication and resource authorization control can be enabled through a simple file-based
security mechanism.

• Security data can be imported from YAML or LDIF and exported to YAML for portability and ease of
editing / scripting.

• Additional optional security features are available for HTTP and MFBINP conversations, for the Web
Services and J2EE, Web, and Remote File Access conversation types. Listeners can be configured to
require user authentication and/or to restrict access to specific types of requests. See Enhanced
Security for HTTP and MFBINP for more information.

Interface Mapping Toolkit
Back to Top

This release provides the following enhancement:
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• The imtkmake -defmap command now support the following new parameters that enhance the
default mapping support for service interfaces - entrypoint, method, and path.

Licensing Changes
Back to Top

• The SafeNet Sentinel licensing system that was available with previous releases of this product has
been deprecated and is no longer available in release 10.0. This product also uses the Micro Focus
AutoPass licensing technology which was introduced in release 8.0. Starting with release 10.0,
AutoPass is the only licensing technology available in this product.

• The SafeNet Sentinel licenses are no longer supported, and you need to use AutoPass licenses starting
with release 10.0. Contact your account manager to replace your existing SafeNet Sentinel with
AutoPass licenses.

Note: Installing 10.0 on a machine where there are other Micro Focus products or versions installed
that use SafeNet Sentinel licensing might result in some compatibility issues. While the 10.0
installation process has been designed to address such issues, you should be aware of the following
scenarios and if any action might be required to ensure licensing works as expected. See Advanced
Installation Tasks > Licensing Coexistence when Upgrading to Release 10.0 in the Installation section.

Micro Focus Unit Testing Framework
Back to Top

This release includes the following enhancement:

• A new configuration file format has been introduced that enables you to use environment variables in
your unit test code for tests that are compiled for more than one scenario. A portable environment file
can provide environment variables for a test case that has been compiled in multiple ways (for Windows/
UNIX, 32-bit/64-bit, etc...). See Configuring the Run-Time System Environment in your product Help.

OpenTelemetry
Back to Top

This release includes support for OpenTelemetry on UNIX platforms. OpenTelemetry provides observability
of Enterprise Server applications by collecting telemetry data. You can configure OpenTelemetry to emit
the information that you require and in a form that can be consumed by third-party monitoring software,
such as Prometheus, Grafana, and Dynatrace. This can enable you to visualize processes and workflow
performance and behavior.

Visual Studio Integration
Back to Top

This release provides the following enhancements:

• Colorization of items in the editor - there are now more COBOL items that you can configure the editor
colors for from Tools > Options > Environment > Fonts and Colors.

• Server Explorer enhancements - you can now connect to a remote ESCWA, and add remote Directory
Servers to the ESCWA opened in Server Explorer.
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

• Licensing Changes
• Significant Changes in Behavior or Usage - Enhancements
• Significant Changes in Behavior or Usage - Fixes

Licensing Changes

Back to the list

• With release 10.0, the SafeNet Sentinel licensing technology has been deprecated. This can result in
some compatibility issues if you install 10.0 on a machine where there are other Micro Focus products
or versions installed that use SafeNet Sentinel licensing. While the 10.0 installation process has been
designed to address such issues, you should be aware of the following scenarios and if any action
might be required to ensure licensing works as expected. See Advanced Installation Tasks > Licensing
Coexistence when Upgrading to Release 10.0 in the Installation section.

Significant Changes in Behavior or Usage - Enhancements

Back to the list

The numbers that follow each issue are the Support Case Numbers followed by the Issue number (in
parentheses).

• Data Tools
• Eclipse IDE
• Enterprise Server

Eclipse IDE

Back to the list

• A new smart editing preference - Format sentence on period - which formats a sentence according to
the current formatter profile when it is terminated with a period, can be configured from Window >
Preferences > Micro Focus > COBOL > Editor > Typing.

(8294)

Enterprise Server

Back to the list

• Enterprise Server's PAM ESM Module now has a group-filter option that can be used to ignore all user
groups that do not matching a specified pattern. See PAM ESM Module Custom Configuration
Information in your product Help for more information.

3176983 (12500)
• In ESCWA, the Enable Single Sign-On for Unsecured Resources has been renamed to Single Sign-

On Behavior which has three options:

• Disabled - This disables all single sign-on including live enterprise server regions.
• Only Secure and Loopback - This is the old 'default' behavior, single sign-on will be enabled for

secured and localhost resources.
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• Allow Insecure (All) - Single sign-on will be enabled for everything. This list controls two boolean
configuration attributes specified in the commonwebadmin.json file:

• InsecureAutoSignOn - this is an existing attribute.
• DisableAutoSignOn - this is a new attribute, if this is set to true then InsecureAutoSignOn will

have no effect and all single sign-on will be disabled. If set to false then InsecureAutoSignOn
will operate as before.

02663941 (658042)
• In ESCWA, you can now set table column defaults for users. This can be configured from the column

filtering option of the table in ESCWA. If an administrator has not set table defaults then the table
columns displayed will match the ESCWA defaults. You can specify which users are able to configure
default columns. This can be performed by modifying the Table Column Configuration security
resource entity. See Security Resources to Control ESCWA and API Access in your product Help for
more information.

Note: If Table Column Configuration is not specified then ESCWA will use the configuration
specified for the Common Web Administration resource class.  

02618280 (532051)
• The casverify utility has been improved with new functionality and additional verification stages. See

casverify in your product Help for more information.

Note: The changes to its text and JSON output formats are incompatible with earlier versions.

(527008)

Significant Changes in Behavior or Usage - Fixes

Back to the list

The numbers that follow each issue are the Support Case Numbers followed by the Issue number (in
parentheses).

• Compiler
• Eclipse IDE
• Enterprise Server
• File Handling
• Interface Mapping Toolkit
• Micro Focus Directory Server
• Run-Time System

Compiler

Back to the list

• C++ compiler and runtime updates on AIX platforms (AIX platforms only)

If your applications contain C++ code or they rely on third-party applications containing C++ code, you
will be affected by a change IBM have made to their AIX platforms.

IBM has changed the C++ compiler and C++ runtime on AIX from the old xlC compiler and runtime to
the new Clang-based C++ compiler (ibm-clang++_r) and runtime, and your COBOL development
system has been built to work with these new versions .

As you cannot mix C++ code that has been compiled using the xlC compiler with C++ code compiled
with the ibm-clang++_r compiler, this will result in you being required to recompile any xlC-compiled C+
+ code with the new compiler, so it can run in the new Clang C++ runtime.

Before recompiling, ensure that you install the Open XL C/C++ 17.1 (or later) runtime environment and
utilities package; see https://www.ibm.com/support/pages/ibm-open-xl-cc-utilities-aix-1711#DNLD for
more information.
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If you are unsure of your reliance on C++ code, you can run the checkbin script, available from
$COBDIR/bin: run checkbin -h for details. This utility will scan a directory structure or file and report
any dependence on the xlC C++ runtime, which would indicate code that needs recompilation.

• The intrinsic function LENGTH and special register LENGTH OF were not always returning the correct
result for PIC N NATIONAL fields. These have been updated to the correct behavior, namely returning
the number of characters for the former and number of bytes for the latter. If your legacy code has been
relying on the previously incorrect behavior, results might now differ.

(613039)
• Generated code only (excluding Intel x86 32-bit platforms): an error when moving from a COMP-6 item

to another COMP-6 item when the SIGNFIXUP Compiler directive is specified has been fixed.

(665005)

Eclipse IDE

Back to the list

• The Skip all breakpoints option, available in the Breakpoints view for COBOL programs, can now be
toggled on and off during an active debug session.

(429042)
• From the Server Explorer in Eclipse, remote catalog entries can now be opened in the Data File

Editor when they are running through a Fileshare server.

(485063)
• A new preference can be set within Eclipse to add search paths for copybooks within standalone files.

Select Windows > Preferences > Micro Focus > COBOL > Standalone Files > Copybook Paths,
and then add one or more paths (or environment variables containing paths) to be searched when
debugging. When the paths in a symbols file cannot be found (for example, source has moved and
debugged from a different location) the missing copybooks are searched for along these paths until a
match is found.

02598103 (517053)
• A new preference, Preserve Ant build file for Maven projects has been added to the Micro Focus >

Builder preference page. Select this option to automatically create a build file (.cobolBuild) when
importing a Maven project.

02540902 (443016)
• For new workspaces, the Server Explorer view no longer contains a connection to the local ESCWA

server by default. You must add the connection manually, when required.

(656022)
• New COBOL projects created under a Japanese locale now default to a source encoding of UTF-8. This

new default can be changed by a new preference setting in Preferences > General > Workspace >
Source encoding directives. Also, within each project, this setting can be overridden at the usual project
levels (project settings, build config, etc...) by using the SOURCE-ENCODING directive. Additionally, the
COBOL project settings (Properties > Micro Focus > COBOL) contain a new setting - source-
encoding - which also explicitly passes through the file encoding to the Compiler. This setting can be
used instead of the previous method of specifying the SOURCE-ENCODING directive within Additional
directives.

(481005)
• The option to specify a script file for environment variables has been removed from the Enterprise

Server runtime launch configuration, as it is not supported for this type of configuration.

02661247 (543073)
• The Generate Client wizard now enables you to select YAML files, and use them to generate web

service clients.

(648043)
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Enterprise Server

Back to the list

• When running with TRANCLASS active, TD Queue transaction triggering was not working.

02737664 (629076)
• ASSIGN INVOKINGPROG did not behave correctly when a CALL was involved.

02662244 (543070)
• A DPL over a SYNCLEVEL2 connection could result in an XA start being driven out of sequence

resulting in a protocol error.

02583717 (477027)
• In a TRANCLASS enabled enterprise server region with a high volume of XA transactions, the logging

overhead could cause performance degradation. This has been improved.

02560536 (468059)
• The PAC compatibility checks that run at startup have now been relaxed. Consistent platform and bitism

are still checked, but product version checks are no longer carried out. The
ES_PAC_MIN_COMP_CHECK environment flag has now been deprecated.

Note: Enterprise Server will still carry out record compatibility checks during start up.

(19756)
• The statusCodes flag has been added to some ESCWA API endpoints which can be used to enable

ESMAC to return appropriate HTTP error status codes instead of embedding failure messages in
successful responses. In a future product release, the new behavior will be enabled by default in the
version 2 of the API and the flag will be removed. The version 1 of the API will maintain the current
behavior.

02601489 (506061)
• ESCWA now limits the session timeout to 20 days. If an existing configuration is greater than that it will

be limited to that value.

(665130)
• In ESCWA, the Listener Properties page now limits user inputs when the smem protocol is selected.

Multiple host names are not permitted, and port selection is also not permitted.

Note: API functionality remains the same.

(665044)
• On UNIX platforms, the casverify utility no longer lacks the detailed file and folder path checking

previously only supported on Windows platforms.

(407163)
• Runaway timeout was intermittently incorrectly calculated.

02529887 (468050)
• The JSON output format for the casverify utility has changed. Messages specific to casverify

itself are no longer identified by "msgout" but under a "messages" array.

(570009)
• For Enterprise Server application failure reports and storage dumps generated by runtime errors, the

RTS error code is now taken into account during es-dump-limit (ES_DUMP_LIMIT) processing. Runtime
errors with differing error codes will now be treated as distinct.

02660093 (561067)
• The Allow no-password signon for default users property has been added to the ESCWA Advanced

Region Properties page. If this property is set to false, an explicit signon request with no password
matching an enterprise server default user account will no longer be treated as a no-password verify,
and will instead result in a not authenticated failure.
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02728103 (625033)
• When no connection string is supplied through ESCWA/MFDS/esfadmin the vsam_esm module will

default to C:\ProgramData\Micro Focus\Enterprise Developer
\es_esm_file_directory.This directory will have been configured through running mfsecconv
init, which is called by the product installer in 10.0 and later.

(545065)
• The es_default_security.yaml file is now supplied with the product and is located at

%ProgramFiles(x86)%\Micro Focus\Enterprise Developer\etc (Windows) or
$COBDIR/etc/vsam_esm (UNIX). You can use this file as a template to configure the VSAM ESM
Module. See the VSAM ESM Module topic in your product Help for more information.

(613052)
• Client connection to Micro Focus Directory Server (MFDS) would sometimes convert a fully qualified

host name to just the simple host name. This could result in TLS connection issues if this did not exactly
match the host names specified in the certificate.

02587914 (486048)

File Handling

Back to the list

• The Micro Focus file handler now passes correct information to the third-party file handlers for the
implementation of the FS_RENAME_FILE routine.

02794472 (559042)

Interface Mapping Toolkit

Back to the list

• The base path is no longer part of the Service name field in the Properties dialog box of REST Web
service Deployment Server tab. (It is only visible in the Advanced Settings of the service name.)

02795415 (651091)

Micro Focus Directory Server

Back to the list

• When starting or stopping an enterprise server region using MFDS or the ESCWA user interface, the
casstart and casstop /m parameter would use the MFDS IP address rather than the host name,
which could result in an issue if TLS certificates were used that required a particular host name.

02603383 (505074)
• An issue introduced Patch Update 1 resulted in ESCWA not listing all enterprise server regions for

legacy import if they contained script data and the MF Directory Server was not sufficiently authorized
to import script data.

(636060)
• The Micro Focus Directory Server (MFDS) Start on System Start enterprise server region option on

the ESCWA General Properties page was not working because the Automated Execution Control
Enterprise Server Credentials were not being applied correctly.

02795649 (652065)
• When exporting enterprise server regions registered in the MF Directory Server using XML format,

regions for which the user did not have read/write access could also be exported.

(526005)
• Issues existed with importing enterprise server regions saved in JSON, XML, and Legacy format into a

MF Directory Server, which resulted in incorrect listener states and counts.
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(559058)
• You can now control the execution and update permission for an enterprise server region's start and

stop, and on unrespondent scripts, by using a new LDAP Enterprise Server Administration security
resource class Scripts entity. If this security resource entity has been specified with appropriate access
control entries, the MFDS session will require Update permission in order for the authorized user to
modify a region s script or to enable or disable it. In addition, for a script to execute, then you must
specify Execute permission. See Class - Enterprise Server Administration in your product Help for more
information.

Note: This is not a region restriction, but applies to the MFDS instance where the region is
specified. If no security or MFDS Internal Security is configured for use then region scripts will not
be executed nor will they be able to be modified. The Scripts resource is not a security resource
created by default. It can be created by the ESCWA interface or other LDAP administration
configuration tools.

Important: In future product versions, the access control that uses the Scripts security resource
will be a requirement in order for any region s scripts to be executed or modified.

02822038 (499063)
• The default UI Session Timeout value for MF Directory Servers has changed from -1 (no timeout) to

600 seconds (10 minutes). The default value for the MF Directory Server API Session Timeout has
been reduced from 3600 seconds (an hour) to 1200 seconds (20 minutes).

(628068)

Run-Time System

Back to the list

• The Java/COBOL application launcher - cobjrun - now supports Java command-line argument files.
See https://docs.oracle.com/en/java/javase/17/docs/specs/man/java.html#java-command-line-argument-
files for details on how these files should be constructed.

02744842 (636023)
• AIX 7.3 only: a dependence on Open XL C to create COBOL executables or shared objects has been

removed.

02674547 (565031)
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Known Issues
Refer to the Known Issues and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

• .NET COBOL projects only support Windows and Linux OS. The Create a new project dialog box in
Visual Studio, however, shows other platforms as supported.

• If, after installing the product for Visual Studio 2022, you cannot access the Micro Focus functionality,
execute the following command from a Visual Studio command prompt:

devenv /updateconfiguration

• JVM COBOL applications that run on AIX7.3 using Java versions 21.0.1 or 21.0.2 (IBM Semeru
Runtime Open Edition) show intermittent errors in the Java runtime (‘java.lang.SecurityException:
SHA-256 digest error’) resulting in the application not running as expected. The product .jar files are
signed.

• In Visual COBOL 4.0 and 5.0 in an extremely small and limited set of cases, an issue could occur with
running .NET executables and .dll files, or JVM .class files, created with an earlier version of the
product. This issue only occurred if:

1. The application performs an IS NUMERIC condition test on a variable declared with USAGE
NATIONAL.

2. The application has been created with Visual COBOL 3.0 or earlier, then executed in Visual COBOL
4.0 or 5.0.

In these rare cases, the IS NUMERIC test could provide the wrong answer.

In order to resolve this issue, in Visual COBOL 6.0 and later, the .NET COBOL and JVM COBOL run-
times reject any program using IS NUMERIC on a NATIONAL item which was compiled with a version
5.0 or earlier of the product. You receive a "missing method" exception. To resolve the issue, you need
to recompile any programs that use this construct in the newer versions of Visual COBOL.

Program that do not use NATIONAL data, or those that have been recompiled in Visual COBOL 6.0 or
later are not affected.

Known Issues | 17



Resolved Issues
This section describes resolved issues in this release that resulted in product enhancements, and those
that resulted in product fixes.

• Resolved Issues - Enhancements
• Resolved Issues - Fixes

Resolved Issues - Enhancements

Back to the list

The numbers that follow each issue are the Support Incident Numbers followed by the Defect number (in
parentheses).

• Compiler
• Database Connectors
• Eclipse IDE
• Enterprise Server
• Interface Mapping Toolkit
• Micro Focus Common Client
• Micro Focus Cryptographic Library

Compiler

Back to the list

• For the processing of XML GENERATE, JSON GENERATE, and JSON PARSE statements, data names
with a leading # character are now treated as though the character was not present. This ensures valid
XML and JSON documents are maintained.

(529106)
• Under the MF dialect, you can now use the FREE statement to directly free memory allocated via the

ALLOCATE statement, by using FREE ADDRESS OF data-name. This negates the need to specify a
returning pointer during allocation (i.e. ALLOCATE data-name RETURNING my-pointer) and then
freeing the pointer.

(528109)

Database Connectors

Back to the list

• The new CARRIAGE-CONTROL-FILTER XFD directive provides the same functionality as the
CARRIAGE_CONTROL_FILTER runtime configuration variable, allowing carriage control characters to
be retained when AcuXDBC reads a LINE SEQUENTIAL data file. See CARRIAGE-CONTROL-FILTER
directive in your product Help for details.

02669873 (557005)

Eclipse IDE

Back to the list

• An enhancement has been made to pre/post build events that will monitor the output generated from
any script run, and if an error message is displayed in the required format, then this will be processed in
the IDE and error markers places against the appropriate source file. Also, if the executed script returns
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a non-zero exit code, then this will also be handled correctly in the build console output. See Pre- and
post-build processing events in the product documentation for more details.

02651165 (542091)
• A new preference has been added to the clean up preferences profile - Identifier case style. This

enables you to specify your preferences for the case style of the COBOL identifiers (lowercase,
uppercase, or no preference).

(505043)
• Improvements have been made regarding Micro Focus Directory Server (MFDS) creation required when

creating new remote projects, specifically to ensure that a unique name is used if another MFDS
already exists.

02577154 (559012)
• Improvements have been made internally to the storing of server-specific settings when working in

Server Explorer.

(630043)
• When debugging in Eclipse, a new error message has been added to the Expressions view for

expressions that contain indexed tables with invalid indexes.

02596514 (517042)

Enterprise Server

Back to the list

• You can now archive the auxiliary trace file by setting the archive_auxiliary_trace property to
true. You can set this property in the Enterprise Server Common Web Administration (ESCWA)
interface on the Advanced Region Properties page. See Auxiliary Trace in your product Help for more
information.

(425091)
• In ESCWA, validation has been added to file path inputs to ensure they do not contain leading or tailing

white space characters.

02513150 (446067)
• Exporting an enterprise server region as a JSON file will now be formatted.

02818032 (510031)
• Two new audit event codes have been added, 5 10 and 2 21. See Audit Event Codes in your product

Help for more information.

02809915 (658081)
• In ESCWA, the Password Change Enabled check box has been added to the Security Settings page.

Checking this enables you to change a users password when they log on.

02589857 (498029)
• In ESCWA, a new Active XA Resources widget has been added to the dashboard. See Dashboard in

your product Help for more information.

02621260 (517076)
• In ESCWA, you can now remove locks for enterprise server regions that are part of a Performance and

Availability Cluster (PAC). You need to be able to stop an enterprise server region in order to remove
locks. The OPERCMDS(CASSTOP) resource will be checked.

Caution: Incorrectly removing locks can result in system instability and corruption or loss of
data.You can contact Micro Focus Customer Support for more information and guidance on
removing locks.

02659029 02869605 (545043)
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• The casverify utility has been improved with a new verification stage to check connectivity to Scale
Out Repositories (SOR) and key records for Performance and Availability Clusters (PAC) enabled
enterprise server regions.

(549010)
• The casverify utility has been improved with new external security manager checks against

configured default users and provided user credentials. Also, step names have became more concise,
which might affect scripts consuming casverify output.

(609033)
• If the Micro Focus Common Client (MFCC) attempts to bind to an MFDS directory using configured

credentials, and the credentials are rejected, it will retry the bind anonymously. This emulates the
behavior of older product releases and is not a security weakness since it will only succeed against
non-secured directories.

(673053)
• The password-expiration heuristic mechanism (expiration-check configuration setting) of the MLDAP

ESM Module has been enhanced to improve accuracy under a number of conditions with various LDAP
servers. Micro Focus recommends that customers using LDAP-based security for Enterprise Server
with bind-mode user verification enable this setting as it results in more precise and accurate return
codes from ESF Verify (user authentication) operations. See MLDAP ESM Module Bind Rejection
Heuristics in your product Help for more information.

02547852 (472036)
• The expiration-check option of the MLDAP ESM Module now supports checking for the commonly-

used LDAP user attributes passwordExpirationTime and pwdChangedAt, when attempting to determine
whether a user bind was rejected due to an expired password. This improves the accuracy of the error
codes returned when using LDAP-based security with bind-mode user verification.

02520274 (411002)

Interface Mapping Toolkit

Back to the list

• COBOL clients now correctly format an x-www-form-urlencoded JSON request body.

02495086 (402050)
• The generated COBOL Web service client proxy program now keeps the communication session open

for the duration of potentially multiple service-invocation calls.

02441897 (385004)

Micro Focus Common Client

Back to the list

• When the Micro Focus Common Client (MFCC) needs to use MFDS to find the location of a service, it
now by default tries to use the readonly account configured as part of the default Enterprise Server
security to bind to MFDS. This is enabled through the mf-client.dat configuration file, and can be
changed after installation. The effect of this change is that functions such as listing deployment listeners
with the imtkmake command will typically work in a fresh product installation with no further
configuration changes required.

(656131)

Micro Focus Cryptographic Library

Back to the list

• The TLS Certificate Checking Utility is a new executable that can be used to help diagnose problems
with TLS certificates. It can check the validity of certificates, verify certificate chains, check that
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certificates and private keys match and check that a certificate contains a SAN that matches a provided
hostname/address. It improves TLS usability by diagnosing TLS certificate problems.

(666106)

Resolved Issues - Fixes

Back to the list

The numbers that follow each issue are the Support Case Numbers followed by the Issue number (in
parentheses).

• Common Communications Interface
• Compiler
• Data Tools
• Debugger
• Documentation
• Eclipse IDE
• Enterprise Server
• Enterprise Server Auditing
• File Handling
• Interface Mapping Toolkit
• MFUnit Testing Framework
• Micro Focus Directory Server
• Micro Focus License Administration
• Run-Time System
• SQL: COBSQL
• SQL: DB2 ECM
• SQL: OpenESQL
• Visual Studio Code
• Visual Studio IDE
• XML Support

Common Communications Interface

Back to the list

• MRPI clients no longer experience high CPU usage when trying to contact a TLS enabled Micro Focus
Directory Server (MFDS).

(474026)
• The CreateDemoCA script will now error with an informational message if the target directory does not

exist.

(679011)
• Memory leaks occurred on outbound connections.

(632064)

Compiler

Back to the list

• When a program was compiled with PERFORM-TYPE(RM) and TESTCOVER an error could occur.

02810218 (656001)
• 64-bit Windows only. Native code only. When a program used parameterized performs, and passed a

two-byte comp-x item by value in a call statement, the NCG sometimes failed to generate the code and
give an error.

Resolved Issues | 21



(549015)
• Windows 64-bit generated code only: an issue where a program uses nested programs and

parameterized sections has been fixed.

(587005)
• An error in generated code when the size of perform-frame local variables is large - typically > 32K - has

been fixed.

(529009)
• All platforms except Intel x86 32-bit. For generated code only, an error accessing perform-frame local

variables has been fixed.

(614046)
• An issue that could occur on AIX platforms only, when a perform range was only performed by

PERFORM statements at the end of a perform range, has been fixed.

(628141)
• An issue in generated code, which was applicable to all platforms except Intel x86 32-bit, regarding

perform frame local variables used as actual parameters to an invocation of a parameterized perform,
has been fixed.

(640145)
• Compiling COPY REPLACING syntax with the CP preprocessor, where more than one replacing text

string is a match, is now processed with correct precedence (that is, the earliest specified).

02615125 (515001)
• Compiling a program with the CP preprocessor, that includes DIRECTIVES-IN-COMMENTS, now has

that option fully respected.

02625721 (522038)
• Optimization work has been completed on internal structures for certain sizes of COMP-5 FILLER items

to mitigate against internal limits being broken when there are a large number of these items.

02622866 (522008)
• The CP preprocessor (and hence the COBSQL preprocessor) now correctly processes lines which,

after COPY REPLACING has taken effect, are longer than the specified SOURCEFORMAT setting
allows.

02694883 (569001)
• A COMPUTE statement with an index name operand now compiles and executes as expected.

02616505 (516028)
• Non-unique paragraphs in non-unique sections now compile and execute as expected.

02673302 02709104 (550010)
• Issues with SBCS Kana characters when used in the sequence area have been fixed.

02805785 (653168)
• A source file with a large number of external programs can now be edited normally, without background

syntax checks slowing down and eventually being disabled.

02802818 (657005)
• Very large programs that exceeded a Compiler system limit and received error message COBCH1674S

Internal dictionary overflow now compile without error.

02744922 (640020)
• A COMP-3 field without decimal places can now be generated by Is2ws as a type-decimal SOAP field

rather than type-integer by adding a nominal trailing V to the PICTURE clause, for example S9(5)V.
This has no effect on the compiled code, but provides a way to emulate the IBM behavior of always
generating type-decimal fields for all COMP-3 items.

02684426 (564011)
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• A COBCH808S Maximum number of data items exceeded error no longer occurs for a program
with a very large number of data items, most of which are unreferenced.

02711056 (615041)
• Previously, cobprof was truncating output to 79 columns when +wide was specified, and was not

truncating when +wide was omitted. This is the opposite of the correct behavior, and so has been fixed.

00367108 (13279)
• Programs with a very large number of predominantly unreferenced data items, can now compile without

breaking system limits.

02622364 (519033)
• The INITIALIZE of a reference-modified numeric item now executes as expected.

02757198 (640076)
• The external names of functions and function prototypes are now checked for consistency.

(666084)
• The syntax LENGTH OF variable-length-group used as a reference modification offset now

executes as expected in all scenarios.

02757096 (637070)
• Illegal MOVE statements involving level-88 condition names now correctly receive a syntax error rather

than generating illegal intermediate code.

02787014 (643131)
• Processing of the BASIS control file now correctly differentiates between a BASIS DELETE statement

and a DELETE token that is part of an EXEC SQL statement.

02629601 (526116)
• The INITIALIZE .. TO VALUE statement now works as expected for table value syntax.

02613611 (510045)
• An INITIALIZE ..TO VALUE statement, which refers to multi-value table syntax, now compiles and

executes as expected.

(9332)
• Within an EVALUATE statement, you now correctly receive a COBCH0334 Cannot follow WHEN

OTHER error if a WHEN clause follows a WHEN OTHER clause.

(516009)
• MOVE statements involving condition names now execute correctly when valid, and are rejected when

invalid.

(652137)
• A program with an incorrect non-unique data name specified as a PROCEDURE DIVISION USING

parameter now has normal IDE functionality available.

02598892 (498059)
• Defining DYNAMIC LENGTH items in the LINKAGE SECTION, to be used as BY REFERENCE

parameters or RETURNING items, is now supported.

(414197)
• The STATIC keyword is now a context-sensitive word under the ENTCOBOL dialect. (STATIC remains a

reserved word under .NET and JVM COBOL.)

(661032)
• In an overlapping perform range, none of the overlapping sections must contain locally declared

variables, nor must they be parameterized. Such scenarios generate a COBCH2024 error during
compilation.

(675020)

Resolved Issues | 23



• If a program containing a SORT statement with an input or output procedure was compiled to .NET or
JVM with a perform type other than MF, bad code could be generated, resulting in an invalid program
exception at run time.

02619192 (515065)
• A SEARCH ALL statement on a variable length group within a class (as opposed to a procedural

COBOL program) could sometimes work incorrectly, as it used the maximum length of the group instead
of the current length. This has now been resolved.

02640706 (526104)
• A READ statement of the form :read type a::bwhere b is a static property in type a exposing a

dictionary or list, was producing an error. This is now fixed.

02669838 (550012)
• An issue in the cob command (introduced in Visual COBOL 4.0) meant that it would not accept

commands of the following form, where the only input file was a shared object:

cob -ze newobj.so libname.so

This has now been fixed.

(649017)
• On Linux platforms running Intel processors, when linking with some C++ libraries, using the ,U

qualifier to the cob -z option, an incorrect message could be produced: cob64: Undefined
symbol(s)        _ZNSs4_Rep20_S_empty_rep_storageE.

02664617 (542072)

Data Tools

Back to the list

• UNC paths were not properly resolved when loading data or structure files.

02819143 (673075)
• There was an issue with deleting multiple records of Line Sequential files simultaneously.

02542533 (425037)
• Previously, records located via the Go To action were not selected in the editor. This is now fixed.

02542696 (427048)
• The Data File Tools Structure view displayed incorrect values for binary data items that were explicitly

defined with a number of storage bytes different to the default.

02649377 (536037)
• When inserting new records, the caret was always positioned at the end of the new record. This is now

fixed.

02542581 (427045)
• In overwrite mode (toggled by Insert key) it was impossible to extend the length of text in fields. This

also applied to functions like Find/Replace. This is now fixed.

02596359 (501005)

Debugger

Back to the list

• An issue has been fixed within the Character Animator, where data item names containing DBCS
characters sometimes could not be queried.

02811986 (658028)
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Documentation

Back to the list

• Searching the help for special registers now returns the main topic on special register usage.

(612069)
• Details of the CP pre-processors COPYINEXEC directive have been added to the documentation. Use

this directive to determine whether CP treats COPY tokens in an EXEC statement as a COBOL COPY
statement or part of the embedded language syntax.

02729687 (623036)
• The documentation for the READ statement has been corrected for rule 26 in the General Rules for

Formats 1, 3, 4 and 5 (Sequential, Relative, and Indexed Files) section.

(489027)
• Dynamic length items are no longer restricted items to enclose in a JAVA-SHAREABLE block.

(666196)
• A formatting issue in the Usage Clause syntax diagram has been corrected - the THREAD-POINTER

and typedef-name-1 elements are now showing correctly.

(505117)
• The parameters for library routine CBL_SUBSYTEM have been updated in the product Help.

(386097)
• The documented restriction for the F run-time switch usage within .NET COBOL and JVM COBOL has

been removed.

02720237 (613087)
• The Z run-time switch has been removed from the documentation.

(520009)
• The documentation now includes an additional rule for the DECLARE statement to point out that, unless

explicitly initialized to a value, a DECLAREd item is initially undefined.

(667190)
• A number of reserved and context-sensitive words have been added to the product in support of the

latest ENTCOBOL enhancements; see the Reserved Words Table and Context-sensitive Words Table
topics in the product help for full details.

(666134)
• An additional step has been added to the tutorial Example 1 - COBOL Calling Java Static Method, to

ensure that the working directory is located on the CLASSPATH when running the example on UNIX
platforms.

(553009)
• A typo has been corrected in the parameter definitions of the documented

CBL_GET_PROGRAM_INFO routine.

(517025)
• The documentation has been updated to clarify some potentially undefined behavior when the cobtidy()

function is invoked; see the cobtidy() help topic.

(637112)
• The documented Byte-stream library routines have now moved to a sub-section under the Files and

Filename Routines section.

(610007)
• The documentation for the CALL statement has been corrected with respect to the LENGTH OF clause,

which can now take a literal value when under the MF dialect.

02182932 (218025)
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• The File Handling Performance documentation has been updated to reference the DATACOMPRESS
and KEYCOMPRESS options, which can significantly improve performance.

02737405 (639069)
• The SORT documentation has been updated to include the BUILD synonym that is supported within the

OUTFIL and OUTREC control statements.

02707437 (613023)
• The documented definition of MFFTP_PROCESS_TRAILS_ONGET control variable has been

corrected to state it works in conjunction with LOCSITE (and not LOCSTAT).

02772554 (644097)
• Additional optional security features are available for HTTP and MFBINP conversations, for the Web

Services and J2EE, Web, and Remote File Access conversation types. Listeners can be configured to
require user authentication and/or to restrict access to specific types of requests. See Enhanced
Security for HTTP and MFBINP in your produce Help for more information.

(635054)
• The option to associate an enterprise server region with a project has been removed from the Visual

COBOL documentation.

00372693 (11386)
• The documentation covering the syntax options required for building the container demonstrations has

been updated to include the hotfix option, when building demonstrations built from a patch update
product.

02590001 (488005)
• The product documentation was missing a product name in the instructions for running a native COBOL

application on a network server.

(550040)
• On UNIX platforms for 10.0, coherence is only supported for 64-bit machines.

(675057)
• The documentation now includes information on how to create a Certificate Authority (CA) trust store

and how to set a password.

02767272 (643023)
• The JSON Processing tutorial in the documentation has had a few cosmetic updates.

(666207)
• The documentation has been updated to reference the level 78 item, MFU-GET-FILE, available in

mfunit.cpy, that can be used to call the MFUGETF routine.

(9316)
• The documentation for the PROPERTY clause has been updated to explain how a property is exposed

based on the setting of the ILARRAYPROPERTY directive.

00373023 (13206)
• Due to the updated version of Eclipse used in the current product, the documented tutorial Compiling a

COBOL Program to JVM Byte Code has been updated.

(665214)

Eclipse IDE

Back to the list

• While in the SVN perspective, COBOL programs and copybooks can now be successfully opened in the
COBOL editor.

02517009 (448019)
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• The exec block colorization functionality has been restored, and the performance issues that originally
affected it have been addressed.

(489095)
• An issue that may prevent the debugger from connecting to Enterprise Server, when using a remote

Eclipse project with SSH tunneling enabled, has been fixed.

(469002)
• When debugging in Eclipse, the value of an indexed level-88 variable expression is now shown in the

Expressions view.

02614691 (509046)
• An issue where breakpoints in JVM COBOL were not always bound when debugging has been fixed.

02406432 (400036)
• When debugging in Eclipse, you can now set a conditional breakpoint expression using the following

operators: <,<=,>,>=.

02178115 (401141)
• An issue has been fixed where an indexed fields value was incorrect in Variables view if there were

COPY statements in the program when debugging a JVM COBOL program.

02028149 (562040)
• On Linux platforms, an issue in the container helper script has been resolved, which was preventing

multiple .car files from being deployed.

02534654 (477016)
• A fault was discovered where building multi-program source files from the IDE on Windows would not

always generate the expected artifacts (specifically, .obj files). This has been fixed so that all expected
artifacts are now generated.

(536033)
• With default security enabled for a local enterprise server, the sign-on process from Eclipses Server

Explorer has a slight change of behavior: when logging on to a security-enabled server for the first
time, the sign-on dialog box is pre-populated with the default credentials, and it will continue to pre-
populate with these details until they fail or another set of credentials are successfully used.

(674031)
• An issue has been fixed where expressions containing the = operator and indexing variables were not

evaluated correctly when debugging JVM COBOL programs.Additionally, this also fixed an issue when
debugging JVM COBOL programs using logical operators in expressions with COMP variables. Now
their numeric value is used in evaluations instead of their display value. For example, a COMP variable
var1 with a display value 0003+ now uses the value 3 when being evaluated.

(562050)
• The Variables view now displays all values correctly for indexed fields.

02028149 (344028)
• When debugging and background parsing is disabled, the hover text on index or working storage items

in a copybook for procedural code now works as expected.

02498245 02491752 (401086)
• A memory leak when debugging JVM COBOL was identified and fixed.

02512293 (405108)
• An issue, where the IDE may crash when using remote SAMBA projects that have extraneous /

characters in the file path, has been resolved.

(488090)
• An issue in the background parser that led to the Outline view not showing correctly has been fixed.

02577316 (464041)

Resolved Issues | 27



• A BMS parser issue was identified where keywords that were split over the end of a line using the
continuation marker were not being correctly handled. This has been resolved.

02624872 (528077)
• When creating an enterprise server region, the 64-bit checkbox is now honored when using a custom

(i.e. non-product-supplied) template.

(615028)
• An issue has been fixed where debug hover in the editor stops working under certain conditions.

(537017)
• If the temporary credentials for the enterprise server security are stored in the vault, they will initially

populate the credentials fields on the Enterprise Server Signon screen.

(664004)
• The following type of message in the build output has been updated to only show when verbose output

is used for linking: [cobollink] Reading additional link objects from:
Program1.objlist

02827465 (665013)
• A potential problem that was generating a null pointer exception during debugging of JVM COBOL has

been fixed.

02498033 (403160)
• A fix has been applied to the editor to ensure that folding block support does not cause exceptions.

(573007)
• When importing an enterprise server region, the run configuration used to perform the import now sets

the CCITCP2_PORT environment variable to the port of the current/selected MFDS.

(487058)
• When creating a new unit test within the IDE, keys and indexes are now correctly created for OCCURS

data items.

(475008)
• A number of code generation errors that occurred when using the Create Unit Test functionality, have

been fixed.

02556886 (452044)
• An issue has been resolved where quick fixes and error squiggles were not getting updated after a

background parse. Also, another issue has been resolved where background parse errors were not
showing a lightbulb icon in the in margin when quick fixes were available.

(505163)
• When changing a project externally to the IDE, changes to the project settings were not being reloaded.

While it is still not always possible to do this automatically (following a checkout from git for example),
the settings should now be reloaded if the project is manually refreshed (using F5 or the context menu
item on the project).

02574490 (468002)
• An error which was occurring between code refactoring and then a background parse has been fixed.

(545072)
• An issue has been fixed where the wrong number of bytes were shown in the hexadecimal

representation of values for COBOL variables when debugging native COBOL programs.

02802748 (652127)
• When configuring a REST Web service, after moving reusable fields to service interface fields, the

mapping is now validated successfully.

02672664 (551002)
• The horizontal ruler now zooms in and out in conjunction with the editor zoom.
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02565757 (484016)
• The wording of the warning dialog message that is shown when debugging a TLS-enabled enterprise

server region fails, has been improved.

02535319 (456002)
• Labels used in the SSH-only remote connection wizard now render correctly.

(675005)
• Within Server Explorer, the Delete option is only available on the context menu for the following nodes:

ESCWA, MFDS, ES region

(674076)
• The IDE now displays a warning when an existing code coverage file is to be overwritten when

exporting new code coverage data.

(421026)
• The documentation now states the need for superuser privileges if the connection to a development hub

is of type Micro Focus Dev Hub RSE or Micro Focus Dev Hub using SAMBA, NFS, etc. and the
Development Hub has been installed without superuser privileges. For these cases, you must ensure
that the RDO daemon is started with superuser privileges. (The Micro Focus Dev Hub SSH Only and
Micro Focus Dev Hub using SSH connection types are not affected by this; connections made to a
development hub not installed with superuser credentials do not need to supply any additional elevated
credentials.)

(666037)
• The Compile File tool in the Micro Focus Project Function Package has been updated so that it can be

configured to wait for a build to finish before returning control.

00726140 00729304 02475372 (74014)
• Changes to the strict IDY debug behavior (require program symbols (.idy) to match the program option

in a launch configuration), introduced in 9.0, could stop core dump debugging from working correctly if
the .idy file did not match the core file. The option to enable or disable this behavior has been added
to the COBOL Core Dump launch configuration, so that this can be controlled in the same way as for
other launch types.

(549005)
• The prompt for ESMAC credentials for an enterprise server region now continues to prompt if you enter

invalid credentials. If you are unable to provide valid credentials, an additional check box (Do not
prompt again until credentials are cleared) has been added to clear the invalid credentials.

02764333 (637100)
• Within Eclipse, when importing an enterprise server region from an XML file, you will be prompted to

select a working directory if the TMP environment variable is not set.

(487059)
• The interface for the COBOL Enterprise Server debug configuration has been redesigned to be more

intuitive. (Its functionality remains unchanged.)

(413169)
• The Get ESCWA Servers function within the Application Workflow Manager now has an additional

(optional) parameter to indicate whether TLS encryption is enabled on a server.

(564010)
• When starting or stopping local regions, the stored credentials are verified, and if invalid, you are

prompted to supply a valid set of credentials before the operation will continue.

(658032)
• The Server Explorer view is empty by default for new workspaces. To connect to an ESCWA instance

(including the default one), use the Create new connection option displayed at the top of the view.

(665061)
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• Additional context-sensitive (F1) help links have been added throughout the Eclipse IDE.

(636048)

Enterprise Server

Back to the list

• The Mfsecrets AES provider now uses umask when creating directories.

(469050)
• Mfsecrets AES provider will now follow the umask when creating files

(464065)
• The Privacy Enhanced Mail file CARootCerts.pem has been updated.

(244065)
• On Ubuntu, running CreateDemoCA.sh, CreateNewUserCerts.sh, or RevokeCertificate.sh

would not produce the required certificates and would fail with a script syntax issue.

(468007)
• ESCWA interactive API library request body documentation has been corrected for pipeline related

endpoints.

(485045)
• Success message from CAS is now checked to return a success. Any message different to the

successful cancel will now be interpreted as an error and ESCWA will notify as such.

(567043)
• ESCWA would crash when deleting a package or handler along with its associated service.

02594214 (489082)
• ESCWA now accepts fully qualified domain names for its bind address.

02493351 (450067)
• ESCWA will now return a unique message if the user if user has been revoked.

02808236 02862909 (651201)
• In ESCWA, on the Services page you can now delete parent services and associated packages in a

single action.

02591547 (489045)
• In ESCWA and version 2 of its API, the DCT recoverable fields did perform correctly.

(561042)
• In ESCWA, an error would occur if non-ASCII characters were sent to ESMAC.

02729629 (625030)
• In ESCWA, the PO/PDS datasets were not loading.

02819576 (658003)
• In ESCWA, the SEPs logs were not displaying.

(652129)
• ESCWA interactive API V2 endpoints failed to operate correctly, including tracing and tn3270Screen.

These have been fixed.

(485029)
• The ESCWA XA Resource page no longer has a notice that it is a technology preview feature.

02534474 (415107)
• ESCWA now allows Catalog Entries with DS Org set to GDG to have empty string to be submitted for

Record Format through the API and it has been hidden by the API

(653208)
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• In ESCWA, the documentation for the Web API contained errors that prevented client generation using
OpenAPI. In addition, fields that were missing have been added and security and resource keys have
been removed from version 2 of the API.

Attention: Micro Focus strongly recommends that you no longer use security and resource keys.

 

(453029)
• In ESCWA, the comparison of PAC strings were treated as case sensitive.

02761061 (638085)
• A problem that caused memory for escwa.exe processes to grow without falling back to normal levels

has been fixed.

02735194 (629100)
• In ESCWA, validation has been added to multi-line file path inputs to ensure they do not contain leading

or tailing white space characters.

02513150 (515022)
• In ESCWA, user token fields were treated as invalid if the stored value contained inconsistent

capitalization.

02634935 (545054)
• In ESCWA, you can now remove locks if necessary. Contact Micro Focus Customer Support for more

information and guidance on removing locks. See Locks in your product Help for more information. The
casstop resource entity is checked as part of the OPERCMDS resource class. A user must have Alter
permissions to do this, which are the same permissions required to stop a region.

(651022)
• User authorization is no longer logged by default and can be enabled in the ESCWA interface.

(682002)
• You can now configure ESCWA to audit request bodies. To enable this auditing, check Audit Request

Bodies in Tracing and Logging Settings. This information is recorded in audit event code 5 10. See
Tracing and Logging Settings and Audit Event Codes in your product Help for more information.

02605389 (525006)
• In earlier releases, the sample LDIF security definitions had incorrect definitions for the DOC*, TCP*,

and URI* resources in the MFESMAC class. This resulted in access failures when attempting to view or
modify those resource types in ESCWA for some administrative users when LDAP-based security was
used and security rules were specified using one of the sample configurations.

(651189)
• The mldap_esm security manager will now load the appropriate threaded/non-threaded version of

libmldap which will result in the correct threaded/non-threaded LDAP library to be loaded.

(273023)
• On AIX, when using VSAM ESM and performing an ESF list resource action against an empty resource

you will no longer receive an error.

(665081)
• When using mfsecconv to export users, the Audit property was not exported correctly. In addition,

when using mfsecconv to convert LDIF to YAML the case of the Mto property for a user was not
correct. These have been fixed.

(665201)
• The esfadmin command-line utility will now accept an ESM server URL of up to 256 characters in

length. Previously this was limited to 80 characters.

(484061)
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• The mfsecconv utility now sets a non-zero exit code if it encounters any serious errors, messages of
error or severe error level are reported. If the new --exit-codes command-line option is specified, it
sets exit code 3 if any severe errors are reported, 2 if any errors are reported, 1 if warnings are
reported, and 0 if only informational messages are generated. This feature will assist in determining
success or failure when running the utility in a script.

(653180)
• The mfsecconv export was creating incorrect YAML.

(652164)
• A number of modifications have been made to diagnostic messages to improve accuracy and relevance

when users attempted to change their passwords under Enterprise Server, when the MLDAP ESM
Module was used with bind-mode authentication.

02547852 (505042)
• An issue existed with the map CN configuration option for the DCAS conversation type.

02528628 (414079)
• If the configuration for a Security Manager using the MLDAP ESM Module explicitly disables Version 1

Authentication (the default behavior), this no longer incorrectly forces DSS wildcard processing to
compatible mode.

02637403 (529091)
• Performing an mfsecconv import of a YAML file containing users with non-literal password verifiers will

no longer cause those users to have an incorrect password.

(666125)
• Enterprise Servers MLDAP ESM Module can now detect the failure to contact an LDAP server for more

types of network failures. Configure the connect timeout setting to permit the module to abandon
hanging connection attempts after a specified time. If the redundant option is enabled for an enterprise
server region (or ESCWA or MFDS) security, a connection timeout will let ESF fail over to another
Security Manager; otherwise, it will let ESF fail the security request after the timeout expires, rather than
hanging indefinitely.

Note: With this change, if a timeout is not configured the module will timeout a connection attempt
after 2147483 seconds, a bit less than 25 days.

02004184 (193042)
• Under certain configurations the MLDAP ESM Module could fail to authenticate user credentials

correctly, allowing users to sign onto Enterprise Server with incorrect passwords.

02652865 (537022)
• For security and SYSLOG AUDIT enabled enterprise server region, mfdatatools2 no longer leaves

File Descriptors with Syslog AUDIT permanently opened.

02792367 02806218 02882401 (652220)
• AIX files based on an ESDS file could not be viewed in ESMAC, ESCWA, or CFLE.

02580365 (486019)
• If a Distributed Program Link (DPL) targeting TXSeries resulted in a backout, this was not being

signaled through EIBRESP.

02639307 (628005)
• When attempting to emit the message CASKC0001E Transaction trn abend abcode. Backout

Successful. the CASSI process could trap with an RTS114 error.

02625044 (576015)
• When a distributed program link (DPL) originator executed a SYNCPOINT ROLLBACK the end of task

processing would report an AEXJ abend.

02725418 (633017)
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• The matching string was incorrectly built.

(297001)
• When casgate processed large volumes of concurrent work, the TCA control block could be left in an

invalid state, resulting in the TCA being disconnected. 

02609989 02612420 02618756 (509036)
• CASOUT requests can hang in server when SEPs are too busy.

02620485 (522007)
• When a 403 Forbidden was issued, the Web error program DFHWBEP was not called. This has been

fixed

02833723 (665237)
• On a busy system, when multiple ITRs where created the KEY could sometimes be a duplicate,

resulting in loss of an ITR. A unique key is now always created.

02615912 (517014)
• When using DISPLAY upon console, the buffer was truncated on the first x00 value.

02793186 (653054)
• Concurrent SET FILE requests were resulting in SEP and enterprise server region crashes.

02629317 (528008)
• After a distributed program link had been executed a subsequent TS queue operation could result in a

SYSIDERR.

02826408 (663078)
• When an enterprise server region was starting in a PAC, it could sometimes rollback an inflight

transaction executing in another region.

02809622 02856124 (657012)
• Whenever trace flags are modified via ESCWA or casutl, a console message is now written to

indicate the trace flags that are currently active.

(499017)
• If a pool thread in the casras process failed to access a record in the PSOR due to an error scenario

that required the thread to reconnect, the thread did not retry to connect. The thread now retries the
connection 10 times. This can be modified by setting ES_SOR_RETRIES to the required number of
attempts. If the thread still fails to connect then a CASRS2107E console message will be generated.

02815996 02819419 02791959 02870114 (665003)
• The casrdo modules were initializing or handling the cascookie browser cookie incorrectly.

02713518 (589017)
• The FLENGTH operand is now initialized to 0 if the container no longer exists. 

02794254 (652175)
• Files with more than 8 indexes were not being displayed in ESMAC.

(484021)
• The Historical Statistical Facility (HSF) CASA_ECI_Function now records the program name when a

PGMIDERR abend occurs.

02406172 (362003)
• New ESMAC sessions did not redirect to the System Sign On page when the default user sign on was

disabled on a secure enterprise server region.

02518847 (415043)
• A trap could occur in casmgr depending on the memory layout, because the memory type was not

checked when processing a chain. This has been fixed

02835014 (665257)
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• When a process died before responding to the process that issued an RPC wait, the recovery failed to
dispatch the waiting process, resulting in a process hanging.

02671714 (561035)
• Invocation of a Tuxedo -hosted program using DPL and specifying a transaction ID was not working.

02538521 02644110 (419027)
• The terminator for custom field entries has been changed from # to x00. This is to prevent field entries

from being truncated at #.

02737028 (629069)
• The CASSI1452E console message now correctly reports runtime errors that caused casmfdbfh

initialization to fail.

02703834 (614008)
• The Internal Reader queue will now be installed in all enterprise server regions in a PAC, and not only

on the first region starting the PAC.

02669519 02678257 (545089)
• Every time casmgr hard killed a process that was stuck after the threshold issued a kill, a dump was

taken. If someone was formatting the dump at the same time, casmgr would be blocked trying to
access the dump file for up to 10 seconds. A kill is now issued for all the stuck processes and only
perform a single dump at the end.

02814032 (666034)
• If a USERIDERR occurred then the partner did not receive the error message.

02744133 (628170)
• When a USERIDERR occurred on a start transaction the socket failed to close. This has been fixed

02739278 (629094)
• When the ENOMEM error was reached after the maximum number of sockets were in use, the listener

would not issue the ACCEPT call, resulting in a blocked listener.

02667973 (613088)
• When creating a resource the name was not being trimmed.

02667449 (542093)
• Using the SET TRANSACTION API did not publish changes to other enterprise server regions in the

PAC.

02634669 02674657 02712535 (528029)
• A shared memory leak could occur during castrc recovery processing.

02568907 (474022)
• When a shared memory lock produces a dump, the lock is released before opening the dump file, and

the lock is acquired afterwards.

02867469 (683131)
• An enterprise server region would fail to start if FUTEX was enabled.

02782113 (643047)
• The casclsec utility failed to receive the userid.

02636579 (526099)
• When a distributed program link passed a large channel, the receiving enterprise server regions buffer

could overflow causing unpredictable behavior.

02600111 (517086)
• HTTP requests exceeding 32 headers to a Web Services and J2EE listener can cause a runtime error

in MFRHCGI. This has been fixed. HTTP requests exceeding 64 headers to a Web Services and J2EE
listener might be rejected with a 400 HTTP response status code with Too many request headers. in the
response body.
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02789436 (651069)
• A delay in transaction routing and DPL introduced by the fix for defect 401124 has been fixed.

02656673 02656960 (543009)
• On Linux platforms, the folder # will no longer be created under /var/mfcobol/es/.

(669063)
• DPL interactions with a Tuxedo CRM server would trap during SL2 exchanges.

02667227 (543087)
• Issuing a program cancel with the no wait option in a PAC, left an orphaned record in the PSOR. This

record is now cleaned up at the end of the command.

02674657 (615074)
• The FILE API response codes were not being propagated back to the remote system.

02785730 (648026)
• Incorrect auth calls were being made while using the DFED.

02628702 (529011)
• Alter or update privileges for a user are only checked when a user is performing an update action.

02619324 (515072)
• The code that matches TS queue instances with TSMODEL prefixes did not always return the closest

matching prefix.

(540013)
• An RTS 114 could occur in cascd or casmgr when the connection to the database used by MFDBFH

was lost.

02575775 (486054)
• The copybook dfhcbtct.cpy has been updated to the latest version.

02821444 (667228)
• The 64-bit Dump Formatter incorrectly formatting trace point 4084 from dfheserv.

02599370 (506047)
• Improvements have been made to the checks for jobs waiting to be dispatched in an enterprise server

region.

02596825 (503030)
• The console message CASSI9051I was not displayed correctly.

(472003)
• Support for multiple system procedure libraries has been added.

02762877 (639081)
• LRECL was truncated when displaying the catalog dataset properties.

02632597 (528027)
• A delay in transaction routing and DPL introduced by the fix for defect 401124 has been fixed.

02645065 (526115)
• In ESCWA, an error caused uninitialized data to be entered into the file size in some cases where 0

should have been displayed.

02527126 02616594 (509029)
• The number of connected SEPs was truncated when the value was higher than 255.

02640448 (528100)
• When using the provided TCPIPSERVICE(HTTPNSSL) from GROUP(DFHWEB), CWBXN would try to

link to a program name only containing spaces as the TCPIPSERVICE had no URM defined.

(645127)
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• New traces have been added to differentiate between GLM, PAC, or LOCKDB locks.

(651046)
• An RTS 173 could occur in the casverify command-line utility during verification for the ESMQXA XA

switch module.

(662068)
• If a network error occurred in one of the CASRAS threads but not in the PING thread, then the threads

that contained the error would stop processing work.

02653594 02792419 (649048)
• Viewing the system trace table from ESCWA (by selecting Trace X) displayed invalid timestamps in all

trace entries.

(566040)
• The find option in CEBR did not work correctly. This has been fixed

02803455 (657011)
• If an application performed a READ FILE ... UPDATE and then invoked a DELETE with RIDFLD() where

the RIDFLD was different from that used in the READ, this would fail with an INVREQ.

02806458 (663049)
• If the buffer to display contained an x 00 then the text was truncated.

02861717 (683119)
• When a user not accessible in the OS user database attempted to start an enterprise server region, a

runtime error would occur in cascfg.

02659924 02782387 (543066)
• Previously, if a Configuration Manager property fails validation, the enterprise server region initialization

would fail with a corresponding CASCF0070E console log error message. Now, in some situations the
property value will be limited and identified by a CASCF0071W console log warning message.

02662199 (622019)
• DPL requests that interacted with Tuxedo CRM would result in a trap in the target during SyncPoint

processing.

02690834 (600001)
• During an INVOKE SERVICE command, the name of the current channel might be incorrectly modified

that is a GET CONTAINER with the CHANNEL option would return CHANNELERR.

02837778 (674022)
• ENDDATA was incorrectly sent when a client using http was disconnected.

02526457 (473050)
• On a busy system with active TRANCLASS, SEPs could hang if they did not receive a response to a

request if some SEPs had died.

02646979 02671418 02751632 02680443 02894969 (547001)
• In ESMAC, user access to the Server Information page can be restricted using the TABLE* resource

under MFESMAC in LDAP.

00368580 (13547)
• When running in a PAC, a RETRIEVE could incorrectly return an IOERR. This would occur if the

transaction was initiated via a START using the TERMID and FROM options and the terminal was
connected to an enterprise server region different to the one processing the transaction executing the
START.

(477002)
• A PACs internal reader jobs were not dispatched when using disposition MOD.

02669519 (561052)
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• The EIBRESP from the remote enterprise server region was not being propagated to the requester
region.

(567053)
• When a SEP is killed before it can pick up work, the terminal was not notified resulting in a hung state.

02552505 (464090)
• The SET-TERMINAL performance has been improved. Shared memory is now used for an ENQ from a

LOCKDB enterprise server region instead of using MFDBFH.

02797529 (651059)
• Authentication checks would fail when the ES_ESM_SECPRFX environment variable was enabled.

02628811 (527015)
• Viewing active Interval Control Elements (ICE) from ESCWA or ESMAC for a TRANCLASS enabled

enterprise server region could unexpectedly fail, or result in a memory access violation in castsc if the
Temporary Storage, Channels and Containers Control (TSC) trace flag was set.

02569568 (508026)
• If a SEP was terminated in the middle of writing to a TS queue, then an infinite loop could be

encountered on all subsequent writes to that queue. This is a result of the queue control record not
being updated. If this does occurs then the first write will retry for a period before returning TIMEDOUT.
All subsequent writes will function as normal.

02625902 (521033)
• Stage descriptions and step names in the casverify command-line utility have been updated to be

more consistent and informative.

(662031)
• On UNIX, Enterprise Server stderr is redirected to /dev/null by default. If you want to redirect it to a

file, set the ES_KEEP_STDERR environment variable to any value. This will create the stderr.PID
file in the workarea.

02855699 (684081)
• Paths containing spaces were not correctly handled in enterprise server region configuration when

using the casverify utility.

(550021)
• The token creation for the BROWSE CONTAINER commands (STARTBROWSE, GETNEXT, and

ENDBROWSE) did not operate correctly.

(685021)
• A CFLE transaction incorrectly set the file to DISABLED when CLOSING.

02852107 (681023)
• Attempting to perform a DPL from TXSeries would fail due to unexpected PIP data included with the

ATTACH.

02622825 02703317 (577002)
• An issue preventing Japanese localization from being displayed on the ESCWA Advanced Region

Properties page has been fixed.

(389049)
• An error is now returned if a castran /v is attempted on a program that has a PPT specified.

(517043)
• When using the EXEC CICS INQUIRE TERMINAL API, the userarea and userarea len were not being

returned correctly.

02767317 (644145)
• Displaying fixed record length files with deleted records on ESCWA and legacy ESMAC interface could

have issues with paging and report an incorrect total record count.
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(685076)
• The import and export of TST resources now supports Process Local and Exclusive queue types.

02757840 (640174)
• The incorrect length was used on query security when RESTYPE was used.

02852945 (679030)
• Starting a cobesdebug session with type=J2EE would result in a communications timeout error.

02594045 (504155)
• Attempting to dynamically update an XA Resource without a close string could result in an RTS114

within the CASA_Update_XRM service.

(653074)
• In a PAC environment, if a transaction had performed an XA prepare and not performed an XA commit

or XA rollback while a new enterprise server region was starting, the recovery transaction started at the
region start could result in an incorrect recovery of an inflight transaction. The process now checks that
it is a true indoubt transaction rather than an inflight transaction.

02575529 (477030)
• Any nameless steps in preflight modules have now been titled appropriately.

(674050)
• The ESCWA v2 dynamic-config API produced a JSON error when a HTTP PUT request succeeds with

further messages.

(653051)
• SYSIDNT was not retrieved correctly when added to the configuration manager.

02635287 (683088)
• Added option for regular JSON output to the casverify command line utility. See casverify in the

product Help for more information.

(658063)
• The embedded template command #INCLUDE is now supported in DOCUMENT APIs.

02728038 (651024)
• When XAID is specified, ISOLEVEL is now set for the dynamic Oracle and DB2 switches.

(472008)
• If the ESXAEXTCFG exit module fails to load when ESLOGGING is enabled in the XA open string, then

a CASKC0025I message will be displayed in the console log.

02725011 (623009)
• The PostgreSQL XA switch module now uses a valid SQL statement to test the current connection.

02721671 (618025)
• The XA recovery transaction failed when using ES_XA_RECONNECT and the connection to the

Resource Module (RM) was lost, the transaction was started too many times which flooded the system.

02532560 (415184)
• XA resource without customization in the XA open string continues to open connection as-is when

Micro Focus Vault support is enabled for other XA resources.

02671497 02675636 02819649 (547042)
• If a container that should have been created by the application was not found, then the error in

DFHJSON-ERROR and DFHJSON-ERRORMSG failed to be returned. This is now fixed.

02801082 (652110)
• mfsecrets no longer displays unhelpful warning about config items not being found in ESCWA logs. 

02543385 (425051)
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• If mfsecrets fails to load the config file it now displays a more explicit error.

(662041)
• After performing a successful migrate, mfsecretsadmin will no longer produce an error message

indicating it failed.

(661078)
• In ESCWA, previously the transaction count on the Live Properties page and API was incorrectly tied

to the task number, which would reset when reaching 99999.

(683114)

Enterprise Server Auditing

Back to the list

• An issue occurred at shutdown when using TLS, this could result in socket closure before the peer had
time to complete receiving.

(272016)

File Handling

Back to the list

• A new index has been added to the RecordLocks tables, to improve performance when accessing busy
files.

02501734 (467002)
• When submitting JCL jobs to a spooler hosted in MFDBFH, a problem where two jobs could be issued

the same job number when the system was under heavy load, has been fixed.

02570363 02599513 (469065)
• When searching on wildcards in a catalog hosted in MFDBFH, sometimes not all matching records

would be returned. This has now been resolved.

02647090 (534024)
• A segmentation fault has been fixed when uploading indexed and sequential files to an SQL Server via

MFDBFH.

02399653 02593176 (364088)
• Handling of stranded locks on region recovery has been improved.

02520632 (409110)
• A number of performance improvements have been made relating to Oracle DBs use of applocks.

02709174 (613045)
• An issue where the MFDBFH cross-region installation scripts would fail to run due to incorrectly

generated statements has been resolved

(645036)
• An issue with deadlocks in MFDBFH has been resolved where we would mistakenly cause a full table

scan, which resulted in TABLOCKs being taken. Indexes have been added to the Filename and Folder
columns of the $DataStore$ table to help prevent this.

02618882 (518002)
• There was an issue where warnings from SQL code execution were reporting a bad file status

incorrectly. This is now fixed.

(526092)
• The fileID has been added as part of an index name, to keep it unique, as previously duplicate index

names were being generated.

(528097)
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• The dbfhview utility will now convert ASCII numeric data (that is not of type COMP), that is stored in
Postgres or SQL Server, to human readable values.

02488484 (399076)
• When using MFDBFH with Oracle databases, all required Oracle functions are now installed, if not

already detected.

02687277 (549030)
• When opening a file hosted in MFDBFH that didnt exist but was marked as optional, it was possible for

a deadlock to occur within the Oracle Openfile procedure. This procedure has now been modified to
remove that possibility.

02684956 (567017)
• If a stored procedure for MSSQL was missing, it would be dynamically installed, but would sometimes

still report an error that it was missing. This error no longer appears.

(559039)
• During a READ operation, the read closest op code now finds the next complete record from the relative

byte address provided.

(387018)
• An error displayed in the IDE stating that a project Could not load assembly

MicroFocus.COBOL.FHRedir.dll has been fixed.

(515058)
• An issue, where programs that included the following copybooks failed to compile when using the

sourceformat(free) directive, has been fixed:
fsdatab.cpyfsdatabv2.cpyfsviewop.cpyfsviewopv2.cpyxfhfcd3.cpy

(403045)
• An issue has been fixed when initializing File Handling tracing when the mfdas32 command is run.

(675076)

Interface Mapping Toolkit

Back to the list

• Web services using very large SOAP messages no longer throw a 153 (subscript out of range) runtime
error.

02778746 (645015)
• COBOL client generation no longer fails due to the presence of escaped XML characters.

02730776 (629048)
• CICS Web Service requestor SOAP messages no longer contain extraneous namespace declarations.

02771747 (644034)
• Top-down generated CICS Web services now correctly handle mixed-content SOAP elements.

02809925 (651214)
• The occurs attribute is now unbounded on service interface fields for COBOL items that have an ODO

clause and that are mapped using default mapping.

02614317 (519020)
• The presence of escaped XML characters sometimes caused COBOL client generation to fail.

02662184 (544055)

MFUnit Testing Framework

Back to the list
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• An issue with COBOL Language Server failing to locate MFUPD_ and MFUWS_ prefixed files when
compiling with the MFUnit Pre-Processor (mfupp) has been fixed.

(530030)

Micro Focus Directory Server

Back to the list

• Creating a new Communications Process could result in a duplication of an existing Communications
Process instance value. This has been fixed. In addition, improvements have been made to enterprise
server region Validate feature which now checks for and fixes duplicate instance values and
Communications Process names that do not match the parent Enterprise Server name.

02627797 (528031)
• The Micro Focus Directory Server (MFDS) could sometimes crash when adding an External Security

Manager (ESM) if no password was supplied.

(446038)
• A TLS-enabled Micro Focus Directory Server (MFDS) would become unresponsive when receiving

requests from MRPI clients.

02552647 (465007)
• Setting Default Process UserID value as a UID rather than userid value caused the MFDS process to

abend when using ESCWA to view enterprise server region data.

02604940 (515077)
• MF Directory Server would fail to start if mfdsacfg.xml options file bind_address value was

numeric rather than containing a valid hostname or IP address in standard format. Older versions of this
file could contain either 127.0.0.1 represented as a 32-bit integer or 0 which represented listen on all
available network adapters. MFDS now accepts either of these numeric address values.

02639711 (529085)
• When creating a Communications Process using the ESCWA API, any input hostname address value

would always be set to *.

02670494 (547019)
• Fileshare server registrations in the MF Directory Server were not being preserved after the Directory

Server was restarted and the Save legacy Micro Focus Servers option was checked.

02597483 (504062)
• In ESCWA, MFDS did not correctly support a shared memory (smem) listener configuration.

(677003)
• When starting enterprise server regions with ISC listeners, transient internal CCI servers with an

MFNAME: prefix can appear in the MFDS or ESCWA user interface server list. To display these server
types you must check the Show System Server Types option.

(484006)
• Fix issue with security configuration rollback if there was an issue verifying proposed configuration for

MF Directory Server using ESCWA.

(665224)
• For Windows x64-only products, the Micro Focus Directory Server was not determining the correct

directory for Visual COBOL binaries.

(657093)
• XRM openstring values were not saved to the configured vault when importing from a repository into the

MF Directory Server.

(683175)
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• In some circumstances, when importing legacy MF Directory Server configuration data the External
Security Manager (ESM) password was not migrated to the Micro Focus Vault Facility correctly.

02574313 (525025)
• The mfActualEndpoint addresses for enterprise server listeners were not being updated or written to

when using an XML file repository.

(495017)

Micro Focus License Administration

Back to the list

• An issue causing the CES daemon to crash has been resolved.

02816509 (617028)

Run-Time System

Back to the list

• Some native COBOL programs invoked via the cobrun trigger could display their command line
parameters incorrectly.

02695958 (607020)
• Previously, the window position of COBOL programs executed with runw/runmw would not get restored

correctly.

02560848 (453001)
• The RANDOM intrinsic function, when called from native COBOL programs, could sometimes return

negative values when using large seed values.

02687376 (615064)
• Previously, accessing files on SMB Azure file shares could result in a COBRT181 error unless the

remote_64bit_access tunable was set.

02745899 (633033)
• Previously, the setupenv.bat script used the built-in RANDOM environment variable to generated

unique temporary filenames. This has now been changed to use a PowerShell command to generate a
UUID, and then uses that in the generated temporary filenames instead.

02787305 (647052)
• Display issues when mixing COBOL ADIS displays with displays of a different type have been resolved.

02581162 (477021)
• Display issues, when mixing COBOL ADIS displays with displays of a different type, have been

resolved.

02581162 (520022)
• Tab characters have been removed from one of the supplied copybooks: cbltypes.cpy.

02783984 (643089)
• Previously, running a COBOL program would erroneously fail with the COBRT253 Cannot load file

- unsupported format (Fatal) error if COBPATH was explicitly set to not include the directory
where the program was located. This has now been changed to return the COBRT173 Called
program file not found in drive/directory error.

(588003)
• The tutorial instructions for COBOL calling Java static method (COBOL/Java Interoperability project)

have been updated to specify the setting of the COBSW environment variable; this variable is required
to address a display issue with the program output.

(567033)
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• A new tunable - entry_point_mapper_invalid_path_error - which is off by default, has been added to
control whether the COBOL Run-Time System should report an error if the ENTRYNAMEMAP
environment variable refers to invalid/non-existent filename and directory paths.

(589018)
• Previously, enabling CTF tracing in .NET applications on Windows that used the native file handler (or

SQL) could result in a COBRTS164 error. This had now been fixed.

02704607 (615004)

SQL: COBSQL

Back to the list

• COBSQL now correctly handles host variable arrays that require COMP/COMP5 conversion.

02668849 (543111)
• COBSQL has been updated to correctly handle an END-PERFORM problem caused by the new swap

byte logic.

02668849 (562025)
• COBSQL has been updated to support sign conversion of CHARSET ASCII + SIGN EBCDIC.

02683191 (573002)
• COBSQL has been modified such that it no longer inserts group information in the EBCDIC conversion

statement when the group variable is a FILLER.

02555993 (442071)
• COBSQL was updated to correctly handle EBCDIC conversion of EXEC SQL OPEN USING

statements.

02804887 (651165)
• COBSQL has been updated to handle EBCDIC conversion of numerical values contained within

redefined group variables.

02584237 (481010)
• COBSQL has been updated to fix compilation issues related to ALPHA-LIT-CONT directive support.

02594669 (489083)
• To correct a compile problem caused by redefined variables, COBSQL has been updated to closely

track group variable information while determining which variables to convert. 

02570841 (464033)
• COBSQL now properly handles the EBCDIC conversion of FETCH FIRST/NEXT statements.

(649057)
• COBSQL has been updated to fix a swap-byte conversion issue that occurred because an

SQLCODE=100 was returned after a multi-row FETCH.

02702058 (596010)
• COBSQL has been modified in this release to handle EBCDIC conversion of FETCH ROWSET

statements.

02687410 (637117)
• COBSQL has been updated to properly terminate EXEC SQL statements that are replaced by dummy

lines during SYBASE precompilation.

02722549 (625013)
• COBSQL now correctly handles EBCDIC conversion of EXEC SQL statements that contain group items

as host variables.

02791368 (649037)
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• COBSQL now recognizes the NOAMODE directive and handles it correctly at run time.

02592714 (516075)
• COBSQL now correctly handles source lines that contain a comma in column 8 immediately followed by

a COMP host variable.

02675814 (547024)
• COBSQL was updated to support ENTRY statements broken into multiple lines.

02426309 (374014)
• COBSQL was updated to use heap instead of an array to handle redefined variables.

02666211 (71231)
• COBSQL has been modified to handle periods in column 72 when the next line is empty.

02485117 (414080)
• COBSQL was updated to handle inline comments after END-EXEC token.

02624353 (520008)
• COBSQL now generates run-time logic correctly for signed numeric data items.

02811569 (658027)
• COBSQL now correctly handles signed numeric data items in a group.

02811569 (656026)

SQL: DB2 ECM

Back to the list

• A problem with .NET 6 processing that erroneously truncated CHAR and VARCHAR values returned
from SELECT statements has been fixed.

02790279 (653118)
• A problem that occurred when compiling a program using the DB2 ECM caused a -1309 SQLCODE

compiler error instead of a connection pop-up dialog.

02354465 (503026)
• A problem using an mfdaemon resource for connection credentials compiling a program using the DB2

ECM has been fixed.

02354465 (643020)
• DB2ECM now compiles without problem when the HOSTVAR directive is used.

02686034 (564020)
• The DB2 ECM produced a connection dialog box instead of automatically connecting when the

mfdaemon was not started and mfaclient.ini contained valid database connection credentials. This
has been resolved.

02354465 (644030)

SQL: OpenESQL

Back to the list

• The native SQL runtime sometimes hung when it encountered the EXEC SQL ROLLBACK TO
SAVEPOINT command. This has been resolved.

02565661 (469019)
• A problem that caused an unwarranted rollback when the last SQL statement issued was a commit or

rollback, and the next SQL statement was a disconnect has been resolved.

02731137 (628044)
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• OpenESQL now handles EBCDIC application correctly when the AMODE(31) directive is used in a 64-
bit environment.

02541041 (454020)
• DSNREXX now handles multiple SQL Statements correctly and without corrupting memory.

02599095 (504116)
• A problem that prevented the OpenESQL runtime from releasing all pinned .NET objects for

MFSQLMESSAGETXT has been fixed.

02690852 (612080)
• OpenESQL has been updated to support user IDs containing a dot.

02637077 (525103)
• A problem with incorrectly cleaning up the ODBC environment sometimes caused OpenESQL to throw

a memory access violation error. In this release, the ODBC environment is cleaned up such that this
error no longer occurs.

02742293 (630097)
• WITH RETURN cursors are now opened as KEYSET type instead of DYNAMIC type.

02541903 (461001)
• A problem that sometimes caused the OpenESQL Assistant to crash in Eclipse has been fixed.

02642239 (534012)
• A compiler error that was caused when using the SQL(GEN-SQLCA) directive without separately

defining SQLSTATE in program code has been fixed.

02743040 02794285 (629124)
• The ODBC ECM error code 12 was sometimes returned during a compile with SQL directives when

processing an interface.

02543269 (425092)
• Running Visual Studio 2022 in a language other than US English or Japanese prevented the Micro

Focus SQL Tools menu from appearing.

(663030)
• A problem that sometimes caused the OpenESQL runtime to leak memory when handling threads has

been fixed.

02646010 (531005)
• The THREAD=ISOLATE SQL compiler directive option now works correctly when a native connection is

used by a managed program running in the same thread.

02670859 (625018)
• The Oracle RM switch module now supports Oracle Client version 21c.

02850631 (673121)

Visual Studio Code

Back to the list

• An issue where Language Server fails to start when a .NET SDK is not available has been resolved.

(508011)

Visual Studio IDE

Back to the list

• When the Store credentials option is unchecked in the Enterprise Server Sign On dialog box, the
credentials are now used when starting a server in the running instance of Visual Studio.
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02545553 02766720 (476012)
• The PATH environment variable is now fully expanded when running a 32-bit application under the

debugger.

02610282 (515003)
• A program compiled to .int can now be specified as the debug target for a 64-bit project.

(640128)
• An issue with missing Japanese translations of some menu items has been resolved.

(544122)
• Visual Studio support has been improved to better handle variable names that appear in structures.

(409031)

XML Support

Back to the list

• XMLPARSE now correctly handles small XML instance documents on the AIX platform.

02799668 (652088)
• XML PARSE has been updated to properly handle XML instance documents with a large number of

content characters within tags.

02575649 (472007)
• The XMLPARSE feature is now available in the Enterprise Server for Stored Procedures product.

02822761 (663037)
• XML READ now performs much faster when a big OCCURS value is used in the XML data-item.

02630023 (525082)
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Other Issues Resolved in This Release
The numbers listed are the Support Incident Numbers followed by the Issue number (in parentheses).

• 02556886 (468003)
• (662117)
• 02537488 (453046)
• 02624110 (520012)
• 02723517 (618034)
• 00363234 (28048)
• 00477923 (61180)
• 02822038 (508052)
• 02394824 02778550 (351052)
• 00373450 02406104 (11527)
• (61096)
• (442036)
• 02823160 (675050)
• 02725405 (628033)
• 02780781 (647035)
• 02743825 (629142)
• 02686079 02733133 (629006)
• 02600111 (597005)
• 02583111 (485001)
• 02783874 (648018)
• 02646617 (540015)
• (513014)
• (568005)
• 02677554 (560014)
• 02730120 (628029)
• (649040)
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Unsupported or Deprecated Functionality
This section includes information about features or functionality that are not supported.

• The SafeNet Sentinel licensing system has been deprecated. This product uses the Micro Focus
AutoPass licensing technology. Contact your account manager to replace your existing SafeNet Sentinel
with AutoPass licenses. Also, see Advanced Installation Tasks > Licensing Coexistence when
Upgrading to Release 10.0 in the Installation section in your product Help.

• The HOSTSIGNS Compiler directive is no longer supported. Micro Focus recommends that you use the
following Compiler directives instead: SIGN-FIXUP, HOST-NUMMOVE, and HOST-NUMCOMPARE.
This is a change since version 3.0 of this product.
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Installation

Before Installing

Downloading the Product
1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/

download/downloadCenter.
2. Select your account and click Entitlements.
3. Search for the product by using any of the available search parameters.
4. Click Show all entitlements.
5. Click Get Software in the Action column for the product you want to download or update.

In the File Type column, you see entries for "Software" for any GA products, and "Patch" for any patch
updates.

6. Click Download on the relevant row.

System Requirements

System Requirements for Visual COBOL for Visual Studio

Hardware Requirements

Visual COBOL has the following requirements in addition to the requirements of Microsoft Visual Studio.
See the Visual Studio documentation for details of the Microsoft requirements.

The maximum disk space requirements are, approximately:

Visual COBOL Sentinel RMS License Manager

1.2Gb 75MB

• This includes the space needed to cache information locally so that you can modify the installation
without the original source media.

• The disk space requirements include the versions of JRE and .NET Framework supplied with the setup
file.

Operating Systems Supported

For a list of supported operating systems, see Supported Operating Systems and Third-party Software in
your product documentation.

Note:

• A 64-bit Windows is required. You can produce both 32-bit and 64-bit applications with Visual
COBOL installed on a 64-bit operating system.
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Software Requirements

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components. A supported version of Microsoft's Visual Studio must
be installed in advance.

Besides the software listed below, the setup file also installs the 64-bit AdoptOpenJDK 17.0.4 (LTS) with
Hotspot.

This product includes OpenSSL version 3.0.8.

• Visual Studio IDE
• Selecting the Visual Studio components to install
• Installing Visual Studio features that are not currently installed
• License Manager requirements
• Other Requirements

Visual Studio IDE

You must have Microsoft's Visual Studio 2022 version 17.8 or a newer one installed in advance.

You need one of the advanced versions of Visual Studio listed below:

Professional, Enterprise or Community Edition - see the next section for the Visual Studio components
you must install.

Microsoft's Visual Studio Express Edition is not supported.

Important:

• When installing Visual Studio, ensure you select the Help Viewer component for installing if you
want to view the Visual COBOL product help inside Visual Studio. When you select components to
install in the Visual Studio installer, click Individual components and check Help Viewer in the
Code tools section.

The following software is also required:

• Microsoft .NET Framework 4.7.2. This is included with Visual Studio.

Selecting the Visual Studio components to install

The Visual Studio installer enables you to customize and only install the workloads and components that
are most suitable for your area of development. For example, you can select the components that are
required for .NET desktop development, ASP.NET Web or C++ development.

If not already installed, the Visual COBOL setup file will install the following components:

• .NET Framework version 4.7.2.
• Debugger
• Data services

A number of workloads and components are optional and only required by specific types of applications or
tasks:

• Azure, WCF, Web, WPF, MSVC, or SQL CLR application development.

Important: The latest version of the C++ x64/x86 build tools component, which is part of the MSVC
Workload, is required to generate some IMTK clients.

If you require any of these, you can select them when you start the Visual Studio installer or, enable them
after completing the installation - see the next section.

50 | Installation



Installing Visual Studio features that are not currently installed

If a feature of Visual Studio was not installed during the Visual Studio installation, the respective
functionality or the project templates for it are not available. You can install a missing feature in one of the
following ways:

Rerun the Visual Studio installer:

1. Start the Visual Studio installer and choose to modify an existing Visual Studio instance.
2. Select the workloads and the components that are missing (for example, ASP.NET and web

development or Help Viewer).
3. Start the Visual Studio installation.

Use the Quick Launch control in Visual Studio:

1. Start Visual Studio.
2. Type the name of the feature in the Quick Launch control - for example, type ASP.NET or Help

Viewer.

A drop-down list with any features matching your search string appears. If the feature is not already
installed, one of the search results will be an option to install it.

Use the Install Missing Feature(s) command in Visual Studio:

1. Start Visual Studio.
2. Click Help > Micro Focus Product Help > Install Missing Feature(s) > Feature Name.

Follow the instructions in the installer to install the missing feature.
3. Alternatively, if a Visual COBOL project template requires a Visual Studio feature which is not currently

installed, the IDE displays an information bar with instructions to install the feature.

License Manager requirements

• For local servers, you do not need to install the Micro Focus License Administration tool separately, as
the setup file installs a new Visual COBOL client and a new licensing server on the same machine.

• If you have any network license servers, you must update them before you update the client machines.
• If you are upgrading from Visual COBOL release 2.2 or earlier, uninstall the license manager before

installing the product.

You can download the new version of the license server software by following these steps:

1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/
download/downloadCenter.

2. Select your account and click Downloads.
3. Select a product and a product version from your orders.
4. In the list of software downloads, locate the License Manager.
5. Click Download to download an archive with the installers.
6. Run the installer suitable for your Operating System to install License Manager on your machine.

Other Requirements

Various actions and operations within your COBOL development environment depend on certain files that
Microsoft distributes in the following package: the Windows SDK package. See Microsoft Package
Dependencies for a full list of actions and operations that require one or both of these packages.

By default, the product installation installs the latest versions of the Microsoft Windows 10 SDK, and the
Microsoft Build Tools for Visual Studio 2017, to their default locations.

If you need to use any other version of these packages, or use them installed to a non-default location, use
the cblms command line utility post-installation to manage this; see Managing the Microsoft Build Tools
and Windows SDK Packages for more information.
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System Requirements for Visual COBOL for Eclipse (Windows)

Hardware Requirements

Visual COBOL has the following requirements in addition to the requirements of Eclipse. See the Eclipse
documentation for details of its requirements.

The disk space requirements are, approximately:

Visual COBOL

2.6GB

Note: The disk space requirements include the size of the Eclipse IDE and the version of Java and
the .NET Framework provided with the Visual COBOL setup file. This includes the space needed to
cache information locally so that you can modify the installation without the original source media.

Operating Systems Supported

For a list of supported operating systems, see Supported Operating Systems and Third-party Software in
your product documentation.

Also note the following:

• A 64-bit Windows is required. 32-bit Windows is not supported. See Installation in Known Issues and
Restrictions.

You can produce both 64-bit and 32-bit applications with Visual COBOL on 64-bit operating systems.

• The Server Core form of Windows Server 2019 is not supported.

Software requirements

Note: This product includes OpenSSL version 3.0.8.

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components.

Requirements for the setup file

• A 64-bit Windows is required. 32-bit Windows is not supported. See Installation in Known Issues and
Restrictions.

• The setup file installs Visual COBOL and the 64-bit version of Eclipse 4.28 (2023-06).

Visual COBOL only supports the 64-bit version of Eclipse. You can use the 64-bit Eclipse to create both
32-bit and 64-bit applications.

• The setup file installs Adoptium's OpenJDK Temurin 17 (LTS) with HotSpot.
• The setup file also installs Microsoft's Visual C++ 2012 and 2015-2022 Redistributables.

Requirements for running the product

• Java 17 (64-bit) or 21 is required to run the Eclipse IDE. The recommended version is Adoptium's
OpenJDK Temurin 17 (LTS) with HotSpot. On Windows, the installer automatically installs Adoptium's
OpenJDK Temurin 17 (LTS) with HotSpot. On Linux, you need to install Java before you install this
product. You can download Adoptium's OpenJDK Temurin 17 (LTS) with HotSpot from Adoptium's Web
site and unpack the archive anywhere on your machine.

• Visual COBOL requires a 64-bit Java installation to run a 64-bit Eclipse.
• Microsoft Windows SDK and Microsoft Build Tools: Various actions and operations within your COBOL

development environment depend on certain files that Microsoft distributes in the following package: the
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Windows SDK package. See Microsoft Package Dependencies for a full list of actions and operations
that require one or both of these packages.

By default, the product installation installs the latest versions of the Microsoft Windows 10 SDK, and the
Microsoft Build Tools for Visual Studio 2017, to their default locations.

If you need to use any other version of these packages, or use them installed to a non-default location,
use the cblmx`s command line utility post-installation to manage this; see Managing the Microsoft
Build Tools and Windows SDK Packages for more information.

See Java Support in Eclipse (Known Issues) in the product help for any considerations when using Eclipse
and Java.

License Manager requirements

• For local servers, you do not need to install the Micro Focus License Administration tool separately, as
the setup file installs a new Visual COBOL client and a new licensing server on the same machine.

• If you have any network license servers, you must update them before you update the client machines.
• If you are upgrading from Visual COBOL release 2.2 or earlier, uninstall the license manager before

installing the product.

You can download the new version of the license server software by following these steps:

1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/
download/downloadCenter.

2. Select your account and click Downloads.
3. Select a product and a product version from your orders.
4. In the list of software downloads, locate the License Manager.
5. Click Download to download an archive with the installers.
6. Run the installer suitable for your Operating System to install License Manager on your machine.

System Requirements for Visual COBOL for Eclipse (UNIX)

Hardware Requirements for Visual COBOL for Eclipse

Visual COBOL has the following requirements in addition to the requirements of Eclipse. See the Eclipse
documentation for details of its requirements.

The disk space requirements are approximately:

Platform Installer type Setup

file size

Disk space

required for

the installation

Disk space

required for

running

the product

Licensing
technology

x86-64
running Red
Hat Linux

Micro Focus 1.66 GB 6.65 GB 3.33 GB 91 MB

x86-64
running SUSE
SLES

Micro Focus 1.38 GB 5.53 GB 2.77 GB 86 MB

System Z
running SUSE
SLES

Micro Focus 856 MB 3.42 GB 1.71 GB 50 MB

x64 running
Amazon Linux
2

Micro Focus 1.38 GB 5.52 GB 2.76 GB 90 MB
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Platform Installer type Setup

file size

Disk space

required for

the installation

Disk space

required for

running

the product

Licensing
technology

x64 running
Ubuntu

Micro Focus 1.38 GB 5.53 GB 2.77 GB 86 MB

x86-64
running Rocky
Linux

Micro Focus 1.66 GB 6.65 GB 3.33 GB 91 MB

Operating Systems Supported

For a list of supported operating systems, see Supported Operating Systems and Third-party Software in
your product documentation.

On some platforms, there is only a 64-bit version of this product. 64-bit versions of the product support
compiling to and running 64-bit programs only.

Software Requirements

The setup file requires that the following software and libraries are installed before you start the installation,
and that certain environment variables are set.

• Software required by the setup file
• Libraries required by the setup file
• Required environment variables
• Software installed by the setup file
• Requirements for running the product
• License Manager requirements

Software required by the setup file

The following software must be installed in advance:

• Java versions 17 or 21 from Adoptium (such as the Adoptium OpenJDK Temurin 17 (LTS) with HotSpot)
and Oracle are required for Visual COBOL for Eclipse.

• The unzip utility.
• The "awk", "ed", "ps", "sed", tar", "sed", and "which" utilities must be installed and added to the PATH.

• On AIX 7.2 and 7.3, the installer requires the Open XL C/C++ 17.1 Clang C++ compiler. You need to
install the Open XL C/C++ 17.1 runtime environment and utilities package.

• If SELinux is installed and you plan to use anything other than core COBOL functionality, or plan to use
Enterprise Server within an environment with ASLR enabled, the "SELINUX" configuration must be
disabled. To do this, set SELINUX=disabled in /etc/selinux/config.

Libraries required by the setup file

The 32-bit libraries listed below are required on both 32-bit and on 64-bit Operating Systems for this
product to install and work correctly.

If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before you
start the installation.
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Library Bitism Platform

32-
bit

64-
bit

SUSE 12 SUSE 15 Red Hat 7 Red Hat 8 Ubuntu
20.4

Amazon
Linux 2

glibc X X X X

libgcc X X X X X

libgc1c2 X X

libstdc++ X X X X X

glibc-locale1 X X X X

libXtst6 X X X X

libXtst X X X X

glibc-devel X X X

gtk3 X X5 X5 X5

PackageKit-
gtk3

X X5 X5 X5

libcanberra-
gtk3

X X5 X5 X5

webkitgtk3 X X5 X5

webkit2gtk3 X X5

xterm Any
versi
on

Any
versi
on

X X X X X X

unzip Any
versi
on

Any
versi
on

X X X X

libgnome X X

libgtk-3-0 X X7 X7 X

gtk3-tools X X7 X7

gcc23 X X X X X X X

cpp2 X X X X

libnotify-tools4 X X X X

libnotify X X

libjasper1 X X X

libjasper4 X X

systemd-libs6 X

Note:

• Libraries marked with an 'X' are not included in the platform and need to be installed separately.
• * Additional libraries required to use the core_on_error runtime variable. The gdb packages (for the

GNU Project Debugger) can be installed from the install media for your OS.
• 1On 64-bit Red Hat 7, you only need to install glibc-2.17*.x86_64 and glibc-2.17*.i686.
• 2On Red Hat, these libraries are required to enable COBOL to compile.
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• 3On Red Hat, only the 64-bit gcc libraries are required.
• 4For SUSE 12 and later, you might need to install the Notifications Library tools (libnotify-tools).

This is to enable notifications to be displayed by the notify-send tool when starting Visual COBOL
for Eclipse from a desktop icon. Execute the following command to install the libnotify-tools library:

zypper install libnotify-tools

• 5The minimum GTK support required is 3.22. Certain platforms meet this requirement without the
need of installing the libraries manually; for example Red Hat 7.4 and SUSE 12 SP3.

• 6Only required if using 32-bit enterprise server regions on Red Hat where 32-bit systemd libraries
are not installed.

Required environment variables

Before you start the installation, you need to set the environment as follows:

• Set the JAVA_HOME environment variable. When installing the product, set this variable to a 64-bit
Java installation or the installation terminates. For example, execute the following:

export JAVA_HOME=java_install_dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
• Add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH

• You need to set the LANG environment variable to pick up localized messages. If you do not set it as
specified here, the installation will run but you might experience unexpected behavior from the installer.

The LANG settings are English and Japanese only so set it to one of the following locales:

C, default, en_GB, en_GB.UTF-8, en_US, en_US.UTF-8

ja_JP, ja_JP.SJIS, ja_JP.UTF-8, ja_JP.eucJP, ja_JP.eucjp, ja_JP.sjis, 
ja_JP.ujis, ja_JP.utf8, japanese

You can set LANG before running the setup file as follows:

export LANG=C

Alternatively, add it to the start of the setup command line:

LANG=C ./setupfilename

See Using the LANG Environment Variable for details.

Software installed by the setup file

• The setup file installs Visual COBOL and the 64-bit version of Eclipse 4.28 (2023-06). After the
installation, you can install Visual COBOL as a plug-in into other Eclipse 4.28 (2023-06) instances
available on the same machine - see Installing Visual COBOL into other instances of Eclipse.

Note: On SUSE platforms, you can only use the 64-bit version of Eclipse to produce 64-bit
applications; on other 64-bit platforms, you can use Eclipse to produce both 32-bit and 64-bit
applications.

• Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
always installed by default. Use your UNIX/Linux installation media to install it.

Requirements for running the product

• Java 17 (64-bit) or 21 is required to run the Eclipse IDE. The recommended version is Adoptium's
OpenJDK Temurin 17 (LTS) with HotSpot. On Windows, the installer automatically installs Adoptium's
OpenJDK Temurin 17 (LTS) with HotSpot. On Linux, you need to install Java before you install this
product. You can download Adoptium's OpenJDK Temurin 17 (LTS) with HotSpot from Adoptium's Web
site and unpack the archive anywhere on your machine.
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License Manager requirements

• For local servers, you do not need to install the Micro Focus License Administration tool separately, as
the setup file installs a new Visual COBOL client and a new licensing server on the same machine.

• If you have any network license servers, you must update them before you update the client machines.
• If you are upgrading from Visual COBOL release 2.2 or earlier, uninstall the license manager before

installing the product.

You can download the new version of the license server software by following these steps:

1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/
download/downloadCenter.

2. Select your account and click Downloads.
3. Select a product and a product version from your orders.
4. In the list of software downloads, locate the License Manager.
5. Click Download to download an archive with the installers.
6. Run the installer suitable for your Operating System to install License Manager on your machine.

System Requirements for Visual COBOL Development Hub

Hardware Requirements

The disk space requirements are approximately:

Platform Installer type Setup

file size

Disk space

required for

the installation

Disk space

required for

running

the product

Licensing
technology

x64 running
Amazon Linux
2

Micro Focus 657 MB 2.63 GB 1.31 GB 90 MB

Amazon for
Docker

Micro Focus 656 MB 2.86 GB 1.31 GB 90 MB

POWER
running AIX

Micro Focus 775 MB 3.1 GB 1.55 GB 102 MB

System Z
running Red
Hat Linux

Micro Focus 485 MB 1.94 GB 970 MB 113 MB

x86-64
running Red
Hat Linux

Micro Focus 919 MB 3.68 GB 1.84 GB 91 MB

64 running
Red Hat Linux

Micro Focus 539 MB 2.16 GB 1.08 GB 91 MB

64 running
Red Hat Linux

Micro Focus 213 MB 852 MB 426 MB 91 MB

Red Hat for
Docker

Micro Focus 659 MB 2.64 GB 1.32 GB 91 MB

x86-64
running
Solaris

Micro Focus 724 MB 2.90 GB 1.45 GB 33 MB

System Z
running SUSE
SLES

Micro Focus 459 MB 1.84 GB 918 MB 79 MB
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Platform Installer type Setup

file size

Disk space

required for

the installation

Disk space

required for

running

the product

Licensing
technology

x64 running
SUSE SLES

Micro Focus 661 MB 2.64 GB 1.32 GB 86 MB

x64 running
Ubuntu

Micro Focus 661 MB 2.64 GB 1.32 GB 86 MB

SUSE for
Docker

Micro Focus 659 MB 2.64 GB 1.32 GB 86 MB

Ubuntu for
Docker

Micro Focus 659 MB 2.64 GB 1.32 GB 86 MB

x86-64
running Rocky
Linux

Micro Focus 919 MB 3.68 GB 1.84 GB 91 MB

Rocky Linux
for Docker

Micro Focus 659 MB 2.64 GB 1.32 GB 91 MB

x86-64
running
Oracle Linux -
Red Hat
Compatibility
Kernel

Micro Focus 865 MB 3.46 GB 1.73 GB 50 MB

Operating Systems Supported

For a list of supported operating systems, see Supported Operating Systems and Third-party Software in
your product documentation.

On some platforms, there is only a 64-bit version of this product. 64-bit versions of the product support
compiling to and running 64-bit programs only.

Software Requirements

Note: This product includes OpenSSL version 3.0.8.

The following topic lists the software requirements for Visual COBOL Development Hub.

• Software required by the setup file
• Libraries required by the setup file
• Software required to run the product
• Required environment variables
• License Manager requirements

Software required by the setup file

• The "awk", "ed", "ps", "sed", tar", "sed" and "which" "tar" utilities must be installed and added to the
PATH.

• On AIX 7.2 and 7.3, the installer requires the Open XL C/C++ 17.1 Clang C++ compiler. You need to
install the Open XL C/C++ 17.1 runtime environment and utilities package.

• If SELinux is installed and you plan to use anything other than core COBOL functionality, or plan to use
Enterprise Server within an environment with ASLR enabled, the "SELINUX" configuration must be
disabled. To do this, set SELINUX=disabled in /etc/selinux/config.
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• Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
always installed by default. Use your UNIX/Linux installation media to install it.

Libraries required by the setup file

The following table lists the required libraries for Red Hat and SUSE Linux platforms. The setup file checks
that both the 32-bit and 64-bit libraries listed below are installed on both 32-bit and on 64-bit Operating
Systems for this product to install and work correctly.

If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before you
start the installation.

The following table shows which of the required libraries are not installed by default on the specified platforms - X
indicates the libraries are missing.

Library Platform

32-
bit

64-bit s390 SUSE
12

SUSE 15 Red Hat
7

Red Hat 8 CentOS 7 Ubuntu 18
and 20

glibc1 X X X X X X

libgcc X X X X X X

libstdc++ X X X X X X

glibc-devel X X X X X

gcc2, 3 X X X X X X X X

cpp2 X X X X

libgc1c2 X X

• Libraries marked with an 'X' are not included in the platform and need to be installed separately.
• 1On 64-bit Red Hat 7, you only need to install glibc-2.17*.x86_64 and glibc-2.17*.i686.
• 2On Red Hat, these libraries are required to enable COBOL to compile.
• 3On Red Hat, only the 64-bit gcc libraries are required.

Visit the Red Hat Web site for more information.

Software required to run the product

• Java 1.8 (64-bit) or later is required to run Visual COBOL Development Hub. The recommended version
is Adoptium's OpenJDK Temurin 17 (LTS) with HotSpot. You can download Adoptium's OpenJDK
Temurin 17 (LTS) with HotSpot from Adoptium's Web site and unpack the archive anywhere on your
machine.

Required environment variables

• Set the JAVA_HOME environment variable. When installing the product, set this variable to a 64-bit
Java installation or the installation terminates. For example, execute the following:

export JAVA_HOME=java_install_dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
• Add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH

• You need to set the LANG environment variable to pick up localized messages. If you do not set it as
specified here, the installation will run but you might experience unexpected behavior from the installer.
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The LANG settings are English and Japanese only so set it to one of the following locales:

C, default, en_GB, en_GB.UTF-8, en_US, en_US.UTF-8

ja_JP, ja_JP.SJIS, ja_JP.UTF-8, ja_JP.eucJP, ja_JP.eucjp, ja_JP.sjis, 
ja_JP.ujis, ja_JP.utf8, japanese

You can set LANG before running the setup file as follows:

export LANG=C

Alternatively, add it to the start of the setup command line:

LANG=C ./setupfilename

See Using the LANG Environment Variable for details.

License Manager requirements

• For local servers, you do not need to install the Micro Focus License Administration tool separately, as
the setup file installs a new Visual COBOL client and a new licensing server on the same machine.

• If you have any network license servers, you must update them before you update the client machines.
• If you are upgrading from Visual COBOL release 2.2 or earlier, uninstall the license manager before

installing the product.

You can download the new version of the license server software by following these steps:

1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/
download/downloadCenter.

2. Select your account and click Downloads.
3. Select a product and a product version from your orders.
4. In the list of software downloads, locate the License Manager.
5. Click Download to download an archive with the installers.
6. Run the installer suitable for your Operating System to install License Manager on your machine.

Installation on UNIX and Linux (Known Issues)
• If you reinstall Visual COBOL for Eclipse on a UNIX machine, it is possible that Eclipse will start without

loading the Micro Focus features. To solve this, you must delete the .eclipse folder in your home
directory and restart Visual COBOL.

Installing on Linux

On Linux, the RPM installer for Visual COBOL for Eclipse installs a 64-bit version of Java. When you start
the installation, if the 32-bit version of Java is already installed on your Linux machine, you might not be
able to install Visual COBOL. This is a known issue with the Oracle Java installers for Linux which prevents
you from installing both the 32-bit and the 64-bit versions of Java on the same machine. To work around
this problem:

• Download the 64-bit Java distribution in a compressed .tar format from the Oracle Web site.
• Untar the distribution into a location different from the one used for the 32-bit Java version. For example,

untar in /usr/local/java64 and not in /usr/local/java.
• Set JAVA_HOME and LD_LIBRARY_PATH to the 64-bit version of Java so that it is used to install and

run Visual COBOL.

Installing on Red Hat 8.x s390

On Red Hat 8.x s390, the RPM non-root install method is not supported due to errors given by cpio. You
receive the following messages:

error: unpacking of archive failed on file /usr/lib/.build-id/1b/
af99f26c6b4c00ca499a3199a574b73aeb3854;6092b79c: cpio: symlink failed - No 
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such file or directory
error: Micro_Focus_cobol_server-7.0.0.0-100700.s390x: install failed

As a result, the installation in this scenario is incomplete.

Installing while using AFS/Kerberos authentication

If you are using AFS/Kerberos authentication to log onto your Linux system then you need to ensure you
have a local user ID which SOA and Visual COBOL components of the product can use. This user ID must
be set up prior to running the installer. When running the installer you need to specify -
ESadminID=[User ID] on the command line so it is used by the installer.

License Server

You need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.

The following is an example of how to specify these entries correctly in the /etc/hosts file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Product Co-Existence
Note: The following applies to Windows only.

• Visual COBOL and COBOL Server cannot coexist on the same machine.
• Micro Focus Visual COBOL and Visual COBOL cannot coexist on the same machine regardless of

which IDE (Visual Studio or Eclipse) you install.

Basic Installation
The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.

For considerations when installing this product as an upgrade, for additional installation options or non-
default installations, see Advanced Installation Tasks in your product Help.

Installing Visual COBOL for Visual Studio
To install this product:

1. Run the vcvs2022_100.exe file, and follow the wizard instructions to install the prerequisite software
and the product.

The installer installs Visual COBOL, and Enterprise Server for .NET.
2. After installing, if you cannot access the Visual COBOL functionality, you need to execute the following

command from a Visual Studio command prompt:

devenv /updateconfiguration

Note:
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• If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Program and Features,
and rerun the installation file.

• Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact OpenText Support for Micro Focus Products to obtain a relevant license.

• We recommend that you install any updates for Visual Studio and the .NET Framework that are
available at the Microsoft Download site.

• If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with Visual COBOL but you can install it if you wish.

Installing Visual COBOL for Eclipse (Windows)
Note:

• This version of the product is a full install.
• If you have an earlier version of Visual COBOL installed on your machine, check Installing as an

Upgrade before you start the installation - see Advanced Installation Tasks.

These are the steps to install Visual COBOL:

1. Run the vce_100.exe file and follow the wizard instructions to complete the installation.

By default, this installs Visual COBOL in the %ProgramFiles(x86)%\Micro Focus\Visual
COBOL folder and installs a full version of Eclipse 4.28 (2023-06) 64-bit, with the Visual COBOL plugins
already installed, in the C:\Users\Public\Micro Focus\Product Name\eclipse directory.

The setup file installs any missing prerequisite software as listed in the topic Software Requirements.

Note: See Advanced Installation Tasks for information about non-default installation tasks.

Installing Visual COBOL for Eclipse (UNIX)
These are the steps to install this product using the Micro Focus installer:

1. Give execute permissions to the setup file:

chmod +x setup_visualcobol_deveclipse_10.0_platform

2. Run the setup file with superuser permissions:

./setup_visualcobol_deveclipse_10.0_platform

If you don't run this as superuser, you are prompted to enter the superuser password during the install.

The COBOL environment is installed by default into /opt/microfocus/VisualCOBOL, (COBDIR). A
full version of Eclipse, with the Micro Focus plugins already installed, is present in the $COBDIR/
eclipse directory.

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./setup_visualcobol_deveclipse_10.0_platform -installlocation="full path of 
new location"
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Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter
the -help option.

Installing Visual COBOL Development Hub
Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus installer for
installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for installing on Linux.
See your product Help for instructions on how to use the RPM installer.

Before starting the installation, see Software Requirements.

These are the steps to install this product using the Micro Focus installer:

1. Give execute permissions to the setup file:

chmod +x setup_visualcobol_devhub_10.0_platform
2. Run the installer with superuser permissions:

./setup_visualcobol_devhub_10.0_platform

If you don't run this as superuser you will be prompted to enter the superuser password during the
installation.

Note: On Ubuntu, the prompt for superuser password is not available. On this platform you must
either log in as root or use the sudo command to get root permissions before you run the installer.

The COBOL environment is installed by default into /opt/microfocus/VisualCOBOL, (COBDIR).

Enterprise Server System Administrator Process

During the installation process, the installer configures the product's Enterprise Server System
Administrator Process User ID. The Process User ID will be the owner of all Enterprise Server processes
except the one for the Micro Focus Directory Server (MFDS). The Directory Server process (Enterprise
Server Administration) runs as root as this allows it to access the system files and ports.

All Enterprise Server processes you start from Enterprise Server Administration run under the Process
User ID which can affects the file access and creation.

You must supply the user ID at the command line - specify -EsadminID=[ ID ] as part of your
command.

By default, the installer uses the login id of the user that runs the installer for the Process User ID. To
change the user id after you complete the installation, execute $COBDIR/bin/casperm.sh and follow the
onscreen instructions.

AutoPass Licensing considerations

• The installation of this product could affect the AutoPass licensed components running on your
machine. During installation, the licensing shuts down to allow files to be updated. To ensure the
processes running on your machine are not affected, you need to use the -skipautopass option, which
skips the installation of AutoPass:

./setup file -skipautopass
• To protect the AutoPass installation from accidental updating, you can create an empty file named

SKIP_AUTOPASS_INSTALL in /opt/microfocus/licensing as follows:

touch /opt/microfocus/licensing/SKIP_AUTOPASS_INSTALL

While the file is present, the AutoPass installer does not make changes to the installation or shutdown
the running license daemons. If licensing needs to be updated later, you can rerun the
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MFLicenseServerInstall.sh from within the $COBDIR/licensing folder with the force command
line option:

cd $COBDIR/licensing
./MFLicenseServerInstall.sh force

After Installing
• See Changes in Behavior or Usage in your product documentation and in the Release Notes for

important information about changes in this release that might affect existing applications.
• Check the Product Documentation section of the OpenText Support and Services Documentation Web

site for Micro Focus products for any documentation updates.
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Licensing Information
Note:

• The SafeNet Sentinel licensing system has been deprecated. This product uses the Micro Focus
AutoPass licensing technology. Contact your account manager to replace your existing SafeNet
Sentinel with AutoPass licenses. Also, see Advanced Installation Tasks > Licensing Coexistence
when Upgrading to Release 10.0 in the Installation section in your product Help.

• Personal Edition licensing is only available with Visual COBOL for Visual Studio 2022 and Visual
COBOL for Eclipse.

• When you activate Visual COBOL Personal Edition, you can use it for a limited period of 365 days.
After this period, you can either register a new Personal Edition license for 365 days or acquire a
valid full license of Visual COBOL in order to continue using the product.

• This package provides a license per supported Micro Focus Development Hub platform.
• If you have purchased AutoPass licenses for a previous release of this product, those licenses will

also enable you to use this release.
• If you are unsure of what your license entitlement is or if you wish to purchase additional licenses,

contact your sales representative or OpenText Support for Micro Focus Products.

To start Micro Focus License Administration

Windows: To start the GUI Micro Focus License Administration

Windows 10 From your Windows desktop, click Start > Micro Focus License Manager > License
Administration.

Windows 11 Click the Start button in the Task Bar. Use the search field in the Start menu to find and
start License Administration.

Windows: To start the command-line Micro Focus License Administration tool

1. At a command prompt, navigate to:

C:\Program Files (x86)\Micro Focus\Licensing

2. Type cesadmintool.bat, and press Enter.

UNIX

Log on as root, and from a command prompt type:

/opt/microfocus/licensing/bin/cesadmintool.sh

Configuring licensing for older products

If you use release 10.0 and previous releases on the same machine on UNIX, you need to the set the
environment variable MFCES_INIT_LOCATION to /opt/microfocus/licensing/bin/ces.ini in
order for licensing to work for the older products. Also, see Advanced Installation Tasks > Licensing
Coexistence when Upgrading to Release 10.0 in the Installation section.
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Installing licenses
You need a license file (with an .xml extension for AutoPass licenses). You need to install AutoPass
licenses into the existing Micro Focus License Administration tool, and not in the AutoPass License Server.

Applying your license file

Windows: To use the GUI Micro Focus License Administration

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:

• Click Browse next to the License file field and select the license file (which has an extension
of .xml).

• Drag and drop the license file from Windows Explorer to the License file field.
4. Click Install Licenses.

Alternatively, you can install the license file from within the IDE as follows:

1. Start Visual COBOL.

If you have not installed a license for Visual COBOL, trying to use the Micro Focus functionality for the
first time after you install the product results in a warning message. Visual Studio displays an
information bar with a message that Visual COBOL does not have a valid license. You can use the
Install license link in the bar, or close the bar.

2. Click Help > Micro Focus Product Help > Product LicensingHelp > Micro Focus > Product
Licensing to open the Product Licensing dialog box.

3. Click Browse next to the License file field.
4. Select the license file (which has an extension of .xml), and then click Open.
5. Click AuthorizeFinish to install the license.

You should see a dialog box with a confirmation that the licenses have been installed successfully.

Windows: To use the command-line Micro Focus License Administration tool

1. Start the command-line Micro Focus License Administration tool.
2. Select the Manual License Installation option by entering 4.
3. Enter the name and location of the license file.

UNIX

1. Start the Micro Focus License Administration tool and select the Manual License Installation option by
entering 4.

2. Enter the name and location of the license file.

To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for Visual
COBOL, contact your sales representative or OpenText Support for Micro Focus Products.
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Updates and OpenText Support for Micro
Focus Products

Our Web site provides up-to-date information of contact numbers and addresses.

Further Information and OpenText Support for Micro
Focus Products

Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• Product Updates on Software Licenses and Downloads, where you can download fixes and
documentation updates.

1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/
download/downloadCenter .

2. Select your account and click Entitlements.
3. Search for the product by using any of the available search parameters.
4. Click Show all entitlements.
5. Click Get Software in the Action column for the product you want to download or update.

In the File Type column, you see entries for "Software" for any GA products, and "Patch" for any
patch updates.

6. Click Download on the relevant row.
• The Examples and Utilities section of the OpenText Support for Micro Focus Products Web site,

including demos and additional product documentation. Go to https://supportline.microfocus.com/
examplesandutilities/index.aspx.

• The Support Resources section of the OpenText Support for Micro Focus Products Web site, that
includes troubleshooting guides and information about how to raise an incident. Go to https://
supportline.microfocus.com/supportresources.aspx

To connect, enter https://www.microfocus.com/en-us/home/ in your browser to go to the Micro Focus home
page, then click Support & Services > Support. Type or select the product you require from the product
selection dropdown, and then click Support Portal.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site for Micro Focus products, https://www.microfocus.com/support-and-services/contact-support/. If you
obtained the product from another source, such as an authorized distributor, contact them for help first. If
they are unable to help, contact us.

Also, visit:

• The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See https://community.microfocus.com.

• The Micro Focus YouTube channel for videos related to your Micro Focus product. See OpenText
YouTube Channel for Micro Focus Products.

• Micro Focus webinars: https://www.microfocus.com/en-us/resource-center/webinar.
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Information We Need
If your purpose in contacting Micro Focus is to raise a support issue with OpenText Support for Micro
Focus Products, you should collect some basic information before you contact us, and be ready to share it
when you do.

Click here to see the Preparing to Raise a Support Case topic on the Product Documentation pages on
OpenText Support for Micro Focus Products, in the product help for Visual COBOL for Eclipse (Windows).

See the Preparing to Raise a Support Case topic on the Product Documentation pages on OpenText
Support for Micro Focus Products, in the product help for Visual COBOL for Visual Studio 2022 (click here).

Click here to see the Preparing to Raise a Support Case topic on the Product Documentation pages on
OpenText Support for Micro Focus Products, in the product help for Visual COBOL for Eclipse (UNIX).

Creating Debug Files
If you encounter an error when compiling a program that requires you to contact OpenText Support for
Micro Focus Products, your support representative might request that you provide additional debug files
(as well as source and data files) to help us determine the cause of the problem. If so, they will advise you
how to create them.
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Copyright and Disclaimer
© Copyright 2024 Micro Focus or one of its affiliates.

The only warranties for this product and any associated updates or services are those that may be
described in express warranty statements accompanying the product or in an applicable license agreement
you have entered into. Nothing in this document should be construed as creating any warranty for a
product, updates, or services. The information contained in this document is subject to change without
notice and is provided "AS IS" without any express or implied warranties or conditions. Micro Focus shall
not be liable for any technical or other errors or omissions in this document. Please see the product's
applicable end user license agreement for details regarding the license terms and conditions, warranties,
and limitations of liability.

Any links to third-party Web sites take you outside Micro Focus Web sites, and Micro Focus has no control
over and is not responsible for information on third-party sites.
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